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ABOUT THIS GUIDE
This guide provides all the information you need to install and use a 
SuperStack® 3 Webcache 1000/3000. It also describes the features of the 
Webcache and outlines how to use those features to optimize the 
performance of the Webcache.

This guide is intended for the system or network administrator who is 
responsible for installing, configuring and managing the network. It 
assumes a basic working knowledge of local area network (LAN) and 
wide area network (WAN) operations.

If release notes are shipped with your product and the information there 
differs from the information in this guide, follow the instructions in the 
release notes.

Most user guides and release notes are available in Adobe Acrobat 
Reader Portable Document Format (PDF) or HTML on the 3Com 
World Wide Web site:

http://www.3com.com/
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Conventions Table 1 and Table 2 list conventions that are used throughout this guide.

Table 1   Notice Icons

Icon Notice Type Description

Information note Information that describes important features or 
instructions

Caution Information that alerts you to potential loss of data or 
potential damage to an application, system, or device

Warning Information that alerts you to potential personal injury

Table 2   Text Conventions

Convention Description

Screen displays This typeface represents information as it appears on the 
screen.

Syntax The word “syntax” means that you must evaluate the syntax 
provided and then supply the appropriate values for the 
placeholders that appear in angle brackets. Example:

To change your password, use the following syntax:

system password <password>

In this example, you must supply a password for 
<password>.

Commands The word “command” means that you must enter the 
command exactly as shown and then press Return or Enter. 
Commands appear in bold. Example:

To reboot the Webcache, enter the following command:

system control reboot

The words “enter” 
and “type”

When you see the word “enter” in this guide, you must type 
something, and then press Return or Enter. Do not press 
Return or Enter when an instruction simply says “type.”

Keyboard key names If you must press two or more keys simultaneously, the key 
names are linked with a plus sign (+). Example:

Press Ctrl+Alt+Del 

(continued)
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Related 
Documentation

In addition to this Guide, the Webcache 1000/3000 documentation set 
includes the following documents:

� Webcache 1000/3000 Online Help

This online help system contains information about the Web interface 
operations that enable you to manage the Webcache. It contains an 
explanation for each operation and the available parameters. You can 
access it by clicking Help on any of the Web interface screens.

� Webcache 1000/3000 Release Note

These notes provide information about the current software release, 
including new features, modifications, and known problems.

There are other publications you may find useful, such as:

� Documentation accompanying 3Com Network Supervisor. This is 
supplied on the CD-ROM that accompanies the Webcache.

Documentation 
Comments

Your suggestions are very important to us. They will help make our 
documentation more useful to you. Please e-mail comments about this 
document to 3Com at:

pddtechpubs_comments@3com.com

Please include the following information when contacting us:

� Document title

� Document part number (on the title page)

Words in italics Italics are used to:

� Emphasize a point.

� Denote a new term at the place where it is defined in the 
text.

� Identify menu names, menu commands, and software 
button names. Examples:

From the Help menu, select Contents.

Click OK.

Table 2   Text Conventions (continued)

Convention Description
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� Page number (if appropriate)

Example:

� SuperStack 3 Webcache 1000/3000 User Guide

� Part number: DUA1611-5AAA01

� Page 25

Please note that we can only respond to comments and questions about 
3Com product documentation at this e-mail address. Questions related to 
technical support or sales should be directed in the first instance to your 
network supplier.

Product 
Registration

You can now register your SuperStack 3 Webcache on the 3Com Web 
site:

http://support.3com.com/registration/frontpg.pl



I
 GETTING STARTED
Chapter 1 Introducing the Webcache

Chapter 2 Installing the Webcache

Chapter 3 Configuring Web Browsers
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1
 INTRODUCING THE WEBCACHE
This chapter contains introductory information about the Webcache 
1000/3000 and how it can be used in your network. It covers summaries 
of hardware and software features and also the following topics:

� What is the Webcache?

� The Webcache and 3Com Network Supervisor

� Webcache — Front View Detail

� Webcache — Rear View Detail

� Default Settings

What is the 
Webcache?

The SuperStack® 3 Webcache 1000 and 3000 are high-performance, 
easily configurable webcache appliances. They offer the following 
benefits to your network:

� Reduced Network Traffic

The Webcache locally stores frequently accessed Web content and 
quickly serves it to the end user on demand. This reduces the amount 
of traffic on the WAN, providing significant cost benefits by reducing 
the bandwidth requirement on expensive WAN links.

� Reduced Web Latency

The end user receives Web content more quickly and with greater 
quality of service if it is served from a local, high-speed Webcache 
than if it is served from the Internet. Web object requests that have to 
travel over long distances are limited to the speed and capacity of the 
slowest link in the path. A Webcache that is closer to the client 
machines reduces the potential for slow links and dropped data 
packets.
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� Smoother Traffic Flow

Traffic surges can stress your network and server. The Webcache can 
help smooth out network traffic and reduce delays in serving Web 
content. As more users request the same Web content, it becomes 
more likely that the content will be stored in the Webcache, and in 
turn the Webcache becomes more effective at eliminating upstream 
traffic.

� Controlled Web Access

The Webcache allows you to control which client machines in your 
network can access the Internet, and which Web sites can be 
accessed. Access Logs show you who has used the Internet and where 
they have been.

The Webcache and 
3Com Network 
Supervisor

The latest version of 3Com Network Supervisor is supplied on the 
CD-ROM that accompanies the Webcache. 3Com Network Supervisor 
provides powerful, intuitive network management for small to medium 
enterprise networks. It automatically discovers network devices and 
reports network activity, stress monitoring and performance metrics for 
network managers. This information helps to provide the most efficient, 
cost-effective use of network resources.

3Com Network Supervisor offers the following support:

� If your 3Com Network Supervisor management station is located on 
the LAN, it discovers the Webcache automatically and displays it on 
the topology map.

� The topology map indicates that the Webcache is a 3Com Webcache 
and uses a caching icon to represent it.

� Double-clicking on the caching icon launches the Web interface of the 
Webcache.
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Webcache — Front 
View Detail

Figure 1   Webcache — Front View

The above illustration shows a Webcache 3000. The Webcache 1000 
contains a single Cache Storage Device and therefore has one Cache 
Storage Status LED on the front panel. The Webcache 3000 contains two 
Cache Storage Devices and can also be upgraded with a third device in 
the future; therefore it has three Cache Storage Status LEDs.

LEDs Table 3 lists LEDs visible on the front of the Webcache, and how to read 
their status according to color. For information on using the LEDs for 
problem solving, see “Solving Problems Indicated by LEDs” on page 32.

Table 3   LED Behavior  

SuperStack 3
®

3C16116

Webcache 3000
Power/Self testActivity

Activity LED

Power/Self
test LED

Cache Storage Status
green = ok

yellow = failed

green = 100 Mbps

yellow = 10 Mbps
Link Status

Cache Storage
Status LED(s)

31 2

Cache Storage Status

32

Link Status

Activity

Link Status
LED(s)

LANLANLAN WAN

LED Color Indicates

Cache Storage Status LED(s)

Green The cache storage device is present and operating normally.

Yellow The cache storage device has failed.

Off The cache storage device is not present.

Link Status LEDs

Green A Fast Ethernet speed (100 Mbps) link is present, and the port 
is enabled.

Yellow An Ethernet speed (10 Mbps) link is present, and the port is 
enabled.

Off No link is present.

(continued)
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Webcache — Rear 
View Detail

Figure 2   Webcache — Rear View

WARNING: WAN and LAN RJ-45 Ports. These are shielded RJ-45 data 
sockets. They cannot be used as standard traditional telephone sockets, or to 
connect the unit to a traditional PBX or public telephone network. Only 
connect RJ-45 data connectors, Switches or Routers to these sockets.

Either shielded or unshielded data cables with shielded or unshielded 
jacks can be connected to these data sockets.

Power Socket The Webcache automatically adjusts its power setting to any supply 
voltage in the range 90-240 VAC.

Console Port The console port allows you to connect a terminal, terminal emulator or 
modem and perform remote or local out-of-band management. The 

Activity LED

Green flashing The cache is active and caching is occurring.

Off The cache is not active. This is normal behavior for an idle 
Webcache.

Power/Self test LED

Green The Webcache is powered-up and operating normally.

Green flashing The Webcache is either initializing or performing a software 
upgrade.

Yellow The Webcache is powered-up but is not caching - a failure has 
occurred.

Off The Webcache is not powered-up. This may indicate a power 
failure.

LED Color Indicates
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console port uses a standard null-modem cable and is set to 9600 baud, 
8 data bits, no parity and 1 stop bit.

WAN Port The WAN port is an auto-negotiating 10BASE-T/100BASE-TX RJ-45 port. 
It is used to connect the Webcache to the network in an inline 
deployment environment.

CAUTION: The Webcache does not support inline deployment in Version 
1.0. You should not connect network cabling to the WAN port.

LAN Port The LAN port is an auto-negotiating 10BASE-T/100BASE-TX RJ-45 port. It 
is used to connect the Webcache to the network in either Proxy or 
Transparent deployment environments. Web network traffic travels to 
and from the Webcache via the LAN port. For more information, see 
“Deploying the Webcache in Your Network” on page 33.

You must connect the LAN port to your network using an appropriate 
network cable. For more information, see the “Cable Specifications and 
Pin-outs” appendix on page 147.

WAN and LAN Port
LEDs

Figure 3   Webcache — WAN and LAN Port LEDs

Table 4 lists LEDs visible on the rear of the Webcache, and how to read 
their status according to color. For information on using the LEDs for 
problem solving, see “Solving Problems Indicated by LEDs” on page 32.
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Table 4   LED Behavior 

The Link Speed LED does not change its state if the link is broken. It 
remains in its current state until a new link is established. Therefore 
Green Off, Yellow On indicates that no link is present and that the link 
was previously 100Mbps. It does not indicate that a 100Mbps link is still 
present.

Default Settings Table 5 shows the factory default settings for the Webcache:

Table 5   Default Settings

LED Color Indicates

Port Activity LED

Green On A link is present.

Green Flashing Packets are being transmitted/received on the port.

Green Off No link is present.

Link Speed LED

Yellow On A Fast Ethernet speed (100 Mbps) link is present.

Yellow Off An Ethernet speed (10 Mbps) link is present.

Feature Webcache 1000/3000

Port Speed 10BASE-T/100BASE-TX Mbps ports are 
auto-negotiated

Duplex Mode 10BASE-T and 100BASE-TX ports are auto-negotiated

Flow Control Enabled with auto-negotiation in full duplex

Console Port 9600 Baud, 8 data bits, no parity, 1 stop bit, no flow 
control

IP Address 192.168.1.253 non-broadcast address

Subnet Mask 255.255.255.0

Domain Name System 
(DNS) Server

0.0.0.0

Default Router 0.0.0.0

Host Name Null

Domain Name System 
(DNS) Domain

Null

Caching Enabled

Caching Mode Proxy

(continued)
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If you initialize the Webcache by selecting System -> Control -> Initialize 
in the Web interface or by entering system control initialize in the 
Command Line Interface, the following settings are retained to allow you 
to connect to and manage the Webcache:

� IP Address

� Subnet Mask

� Default Router

� Domain Name System (DNS) Server

� Host Name

� Domain Name System (DNS) Domain

All other settings are reset to the default values shown in Table 5.

Caching Port 8080

Access Logging Disabled

Web Site Blocking Disabled

Web Client Blocking Disabled

Simple Network 
Management Protocol 
(SNMP)

Enabled but requires configuration

Network Time Protocol 
(NTP)

Disabled

Web Browser 
Auto-Configuration

Disabled

Upgrade Notification Enabled but requires configuration

Upgrade 
Detection/Download

Enabled

Email Notification Events Disabled

Multi Router Traffic 
Grapher (MRTG) Graphs

Always Enabled

admin Password (none)

Password Recovery Enabled

Feature Webcache 1000/3000
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2
 INSTALLING THE WEBCACHE
This chapter contains the information you need to install and set up the 
Webcache 1000/3000. It covers the following topics:

� Package Contents

� Choosing a Suitable Site

� Rack-Mounting the Webcache

� The Power-up Sequence

� Deploying the Webcache in Your Network

� Setting Up the Webcache for Management

� Getting Started Wizard Settings

� Connecting the Webcache to the Live Network

� Network Configuration Concepts

WARNING: Safety Information. Before installing or removing any 
components from the Webcache 1000/3000 or carrying out any 
maintenance procedures, you must read the safety information provided 
in Appendix A of this guide.

AVERTISSEMENT: Consignes de sécurité. Avant d'installer ou d'enlever 
tout composant du Webcache 1000/3000 ou d'entamer une procédure 
de maintenance, lisez les informations relatives à la sécurité qui se 
trouvent dans l'Appendice A de ce guide.

WARNHINWEIS: Sicherheitsinformationen. Bevor Sie Komponenten 
aus dem Webcache 1000/3000 entfernen oder dem Webcache 
1000/3000 hinzufuegen oder Instandhaltungsarbeiten verrichten, lesen 
Sie die Sicherheitsanweisungen, die in Appendix A (Anhang A) in diesem 
Handbuch aufgefuehrt sind.
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Package Contents � Webcache 1000 (3C16115) or Webcache 3000 (3C16116)

� CD-ROM

� User Guide (this guide)

� Release Notes

� Warranty Card

� Power Cord

� Rack-Mounting Kit containing:

� 2 x Rack Mounting Rails

� 2 x Rack Mounting Brackets

� 2 x Adjustable Brackets

� 2 x Front Plates

� 16 x Screws

These items are shown in Figure 4 on page 27.

Choosing a Suitable 
Site

The Webcache must be mounted in a standard 19-inch 4-posted 
equipment rack, and is suited for use in a wiring closet, an equipment 
room, a server room, or telecommunications room. A rack-mounting kit is 
supplied with the Webcache.

CAUTION: Ensure that the ventilation holes in the Webcache are not 
obstructed.

When deciding where to position the Webcache, ensure that:

� Cabling is located away from:

� sources of electrical noise such as radios, transmitters and 
broadband amplifiers.

� power lines and fluorescent lighting fixtures.

� The Webcache is accessible and cables can be connected easily.

� Water or moisture cannot enter the case of the Webcache.

� Air-flow is not restricted around the Webcache. 3Com recommends 
that you provide a minimum of 25 mm (1 in.) clearance.

� Air temperature around the Webcache does not exceed 40 °C (104 °F).
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If the Webcache is installed in a 19-inch rack or closed assembly its local 
air temperature may be greater than room ambient temperature.

� The air is as free from dust as possible.

� The Webcache is installed in a clean, air conditioned environment.

Rack-Mounting the 
Webcache

The Webcache is 1U high and will fit in most standard 19-inch rack 
mounts.

CAUTION: The rear of the Webcache must be supported. This is best 
achieved through the use of a 19-inch 4-posted rack.

CAUTION: Disconnect all cables from the Webcache before continuing.

To rack-mount your Webcache:

1 Place the Webcache the right way up on a hard flat surface, with the 
front facing towards you.

2 Locate the Rack-Mounting Kit that is supplied with the Webcache. The 
Kit contains the items shown in Figure 4.

Figure 4   The Rack-Mounting Kit Contents

You must use the rails and screws supplied with the Rack-Mounting Kit. 
Damage caused to the Webcache by using incorrect rails and screws 
invalidates your warranty.

16 x

2 x

2 x

2 x

Screws

Front
Plates

Rack-Mounting
Brackets

Rack-Mounting
Rails

2 x

Adjustable
Brackets
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3 Attach a rack-mounting bracket to each side of your Webcache using 4 
of the screws provided for each bracket, as shown in Figure 5.

Figure 5   Fitting a Rack-Mounting Bracket to the Webcache



Rack-Mounting the Webcache 29
4 Use an adjustable bracket to secure a rack-mounting rail to the rear of 
your rack as shown in Figure 6. To do this:

a Slide the adjustable bracket onto the rack-mounting rail and attach it 
using two of the screws provided at a position suitable for your rack.

b Use rack-nuts (not supplied) to attach the rack-mounting rail and 
adjustable bracket assembly to the rear of your rack.

Figure 6   Fitting a Rack-Mounting Rail to the Rear of the Rack
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5 Attach the rack-mounting rail to the front of the rack. To do this:

a Insert two screws through aligned openings in the front plate, rack 
and rack-mounting rail as shown in Figure 7.

b Tighten the screws with a suitable screwdriver.

Figure 7   Fitting a Rack-Mounting Rail to the Front of the Rack

6 Repeat step 4 and step 5 for the other side of the rack.
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7 Slide the rack-mounting brackets on the sides of the Webcache into the 
rack-mounting rails.

8 Secure the front of the Webcache to the rack with the captive 
thumbscrews, as shown in Figure 8.

Figure 8   Attaching the Webcache to the Rack

9 Ensure that the ventilation holes in the Webcache are not obstructed.

The Power-up 
Sequence

The following sections describe how to get your Webcache powered-up 
and ready for operation.

Powering-up the
Webcache

Use the following sequence of steps to power-up the Webcache:

1 Plug the power cord into the power socket at the rear of the Webcache.

2 Plug the other end of the power cord into your power outlet.

3 The Webcache automatically powers-up, which takes approximately 
60-90 seconds. During power-up all of the LEDs light and the Power/Self 
test LED flashes green. When the Webcache has powered-up and is 
operating normally, the Power/Self test LED changes to non-flashing 
green.
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CAUTION: The Webcache has no ON/OFF switch; the only method of 
connecting or disconnecting mains power is by connecting or 
disconnecting the power cord.

Checking for Correct
Operation of LEDs

During the power-up of the Webcache, all ports on the Webcache are 
disabled, all of the LEDs light and the Power/Self test LED flashes green

When the power-up has completed, check the Power/Self test LED to 
make sure that your Webcache is operating correctly. Table 6 shows 
possible behavior for the LED.

Table 6    Power/Self test LED behavior

Solving Problems
Indicated by LEDs

If the LEDs on the Webcache indicate a problem, refer to Table 7, which 
contains a list of problems and suggested solutions.

Table 7   Problems Indicated by LEDs

Color State

Green The Webcache is powered-up and operating normally.

Green flashing The Webcache is either powering-up or performing a 
software upgrade.

Yellow The Webcache is powered-up but is not caching — a 
failure has occurred.

Off The Webcache is not powered-up. This may also indicate 
a power failure.

Problem Suggested Solution

The Power/Self test 
LED does not light

Check that the power cable is firmly connected to the 
Webcache and to the supply outlet. If the connection is 
secure and there is still no power, you may have a faulty 
power cord.

On powering-up, the 
Power/Self test LED 
lights yellow

The Webcache has failed during its power-up sequence 
because of an internal problem. Contact your supplier for 
advice.

A link is connected but 
the Status LED for the 
port does not light

Check that:

� All connections are secure.

� The devices at both ends of the link are powered-up.

� The quality of cable is satisfactory.
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Deploying the 
Webcache in Your 
Network

You must determine how you are going to deploy the Webcache in your 
network. The Webcache can be deployed in two ways:

� Proxy Cache mode — The Webcache is connected to a Layer 2 switch 
in your LAN. You must configure the Web browser on each client 
machine in your network to direct its Web requests to the Webcache.

� Transparent Cache mode — The Webcache is connected to a Layer 4 
redirection device — a switch, router or firewall in your LAN which is 
capable of Redirection. No configuration of the Web browser on each 
client machine is needed because the Layer 4 device automatically 
redirects Web requests to the Webcache.

CAUTION: 3Com recommends that you deploy your Webcache on the 
LAN side of a firewall, or on the SuperStack 3 Firewall's DMZ port as 
described in “Deploying the SuperStack 3 Firewall as a Proxy Forwarder” 
on page 35.

The term “Web requests” refers to three types of network traffic; HTTP, 
HTTPS (SSL encrypted) and HTTP-FTP. The Webcache can accept all of 
these traffic types. In Proxy Cache mode, you should configure the Web 
browser on each client machine to use the Webcache as the server for 
each of these protocols.

HTTPS (SSL encrypted) traffic is only passed through by the Webcache; it 
is not decoded or cached.

Proxy Cache Figure 9   Proxy Cache Deployment
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In the Proxy Cache deployment the Webcache is connected to an 
Ethernet switch in your LAN. You must configure the Web browser on 
each client machine in your network to explicitly direct its Web requests 
to the Webcache. For more information on Web browser configuration, 
see “Configuring Web Browsers” on page 49.

All Web requests are received and served by the Webcache. All non-Web 
traffic bypasses the Webcache and is sent directly to the appropriate 
destination. 

If the Webcache fails, access to the Web is lost because each client 
machine has been configured to direct its Web requests to the 
Webcache.

You can avoid this loss of access to the Web by using Proxy Auto 
Configuration (PAC) files to configure the Web browser on each client 
machine. The PAC file can instruct the browser to go directly to the Web 
if the Webcache is not available. For more information, see page 50.

Transparent Cache Figure 10   Transparent Cache Deployment

In the Transparent Cache deployment the Webcache is connected to a 
Layer 4 switch, router or firewall in your LAN which is capable of 
Redirection. The Layer 4 device (also known as a Layer 4 redirector or 
Web-enabled device) automatically redirects all Web requests to the 
Webcache. Therefore no configuration of the Web browser on each client 
machine is needed, which avoids configuration problems and reduces the 
demand on technical support.
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If the Webcache fails, the Layer 4 device will detect the failure and 
redirect Web requests to the WAN, if the device supports Webcache 
health-checks, ensuring that access to the Web is maintained.

Deploying the Webcache in Transparent mode has benefits for the 
security of your network. It ensures that only client machines that are 
inside your network can access the systems and resources within it. This 
eliminates the need for serious access controls.

Migrating from Proxy
Cache to Transparent

Cache Mode

Client machines with Web browsers that are configured to use the 
Webcache as a Proxy Cache (either directly or through Browser 
Auto-Configuration) can continue to use the Webcache as a Proxy Cache 
if you change the Webcache to a Transparent Cache deployment. This 
allows you to gradually migrate the client machines in your network from 
a pure Proxy Cache configuration to a pure Transparent Cache 
configuration, by changing the Web browsers to Transparent Cache 
mode as required.

Deploying the
SuperStack 3 Firewall
as a Proxy Forwarder

The following example describes how to install the SuperStack 3 Firewall 
(3CR16110-9x) as a Proxy Forwarder. The network layout is shown in 
Figure 11 below.

Figure 11   Deploying the Firewall and Webcache Together

1 Install the Webcache as described in this Chapter, taking into account any 
safety information.

a Install the Webcache on a Hub or Switch connected to the DMZ port 
of the Firewall. Use the LAN port of the Webcache for this connection.
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Network Address Translation (NAT) does not apply to the DMZ port of the 
Firewall so you will need to configure the Webcache with a registered IP 
address.

b Set the Webcache to Proxy Mode. This setting can be made from the 
Getting Started Wizard or by selecting Device View > System > 
Caching > Set Caching Mode from the Web interface.

c In the Port Number field enter the number 8080 (this is the default 
value).

d Do not enable Web Site Blocking on the Webcache as the Firewall has 
more advanced filtering abilities and is able to use the 3Com Web Site 
Filter (3C16111) if installed.

2 Install the Firewall according to the Superstack 3 Firewall User Guide 
(DUA1611-0AAA0x) taking into account any safety information.

a On the Web interface of the Firewall click Advanced then Proxy Relay.

b In the Proxy Web Server Address field enter the IP address of your 
Webcache.

c In the Proxy Web Server Port field enter the number 8080.

d Click Update to save your changes.

3 No configuration is necessary on the client machines. The Firewall will 
intercept any HTTP requests for external URLs and will forward the traffic 
to the Webcache.

Setting Up the 
Webcache for 
Management

You can quickly set up the Webcache for management in two ways:

� Setting Up Using the Web Interface — Connect a management 
workstation to the Webcache over an IP test network or directly via a 
cross-over cable. For more information, see “Setting Up Using the 
Web Interface” on page 38.

or

� Setting Up Using the Command Line Interface — Connect a 
management workstation to the Webcache over an IP test network or 
connect a terminal or terminal emulator to the console port of the 
Webcache directly, or through a modem. For more information, see 
“Setting Up Using the Command Line Interface” on page 40.

CAUTION: You must configure the basic settings of the Webcache by 
completing the Getting Started wizard before you introduce the 
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Webcache to your live network. In particular, ensure that the IP settings 
of the Webcache fit into those of your network. For more information, 
see “Getting Started Wizard Settings” on page 43.

Before You Begin To setup the Webcache for management, you must correctly configure it 
with the following information. Ensure that you have this information for 
the Webcache ready before you begin.

� An IP address — for more information, see “IP Addresses” on 
page 45.

� A subnet mask — for more information, see “Subnets and Using a 
Subnet Mask” on page 46.

� A default router address — for more information, see “Default 
Router” on page 46.

� A Domain Name System (DNS) server address — for more 
information, see “Domain Name System” on page 47.

� A Network Time Protocol (NTP) address — for more information, 
see the “System Time” chapter on page 67. You can choose to enter 
the system time manually instead of using NTP.

� A Host Name — The Host Name is combined with the Domain 
Name System domain to give the internet name of the Webcache. 
The host name is the name of the Webcache within the local domain. 

� A Domain Name System (DNS) domain — The Domain Name 
System domain is combined with the Host Name to give the internet 
name of the Webcache. The domain name is a grouping of computers 
with related properties. For example you might group all computers in 
your company in the domain mycompany.com.

Example

The internet (DNS) name webcache.mycompany.com is formed by 
combining the Host Name webcache with the DNS domain 
mycompany.com.

� A Caching Mode — for more information, see “Deploying the 
Webcache in Your Network” on page 33.

� A Caching Port Number — The Caching Port Number is the port on 
which the Webcache will listen for traffic. The default number is 8080. 
The caching port number is only required if you set the Caching Mode 
to “Proxy Mode”.
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Setting Up Using the
Web Interface

You can setup the Webcache for management via the Web interface by 
using a Web browser on a management workstation that is connected to 
the Webcache over your test network, or directly using a cross-over cable.

Setting Up Over the Test Network

The Webcache is pre-configured with a default IP address, which is within 
the range of addresses reserved by the IETF for private IP networks. This 
default address allows you to run the Web interface without any initial 
configuration of IP addresses. The default IP address of the Webcache is 
192.168.1.253.

Figure 12   Setting Up Over the Test Network

To connect the Webcache to the test network:

� The client machine must be in the same subnet as the Webcache to be 
able to access it using the default IP address.

� You must have an IP stack correctly installed on the client machine. 
You can check this by trying to browse the World Wide Web; if you 
can browse, an IP stack is installed. If you do not have access to the 
World Wide Web, you can check that the IP stack is installed by 
pinging another device in your network. For more information, see 
“Pinging Other Devices” on page 91.

Setting Up Using a Cross-over Cable

Alternatively, you can directly connect a client machine to the Webcache 
by attaching a cross-over cable to the LAN port on the rear panel. For 
more information, see “Webcache — Rear View Detail” on page 20.

Figure 13   Setting Up Using a Cross-over Cable
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Accessing the Web Interface

To access the Web interface:

1 Open the Web browser on the management workstation. To display the 
Web interface correctly, use one of the following Web browsers:

� Microsoft Internet Explorer v4.0

� Microsoft Internet Explorer v5.0

� Microsoft Internet Explorer v5.5

� Netscape Communicator v4.5

� Netscape Communicator v4.6

� Netscape Communicator v4.7

Netscape Navigator version 6 is not supported by the Webcache.

For the browser to operate the Web interface correctly JavaScript™ and 
Cascading Style Sheets must be enabled on your browser. These features 
are enabled on a browser by default. You will only need to enable them if 
you have changed your browser settings. Also the Web interface has 
been optimised for PC screens with the desktop area set to 800 by 600 
pixels. 3Com recommends that you set the font size to Small Fonts.

2 In the Location/Address field of the browser, enter the URL of the 
Webcache. This must be in the format:

http://nnn.nnn.nnn.nnn:8081

where nnn.nnn.nnn.nnn is the IP address of the Webcache and 8081 is 
the port on which the Webcache listens. You must enter http:// and the 
port number to successfully access the Webcache using your browser.

192.168.1.253 is the default IP address of the Webcache.

In Netscape, you can enter a shortened URL such as 192.168.1.253:8081 
and Netscape successfully accesses the Webcache. In Internet Explorer, 
however, this URL is not recognized. You must include "http://" at the 
start of the URL i.e. http://192.168.1.253:8081.

3 When the browser has located the Webcache, a user name and password 
screen is displayed as shown in Figure 14.
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Figure 14   User name and password screen

If the user name and password screen is not displayed, see “Solving Web 
Interface Problems” on page 130.

4 Enter your user name and password. For further information, see 
“Logging in as a Default User” on page 58. Click OK.

5 The Getting Started wizard is displayed when the Web interface has 
loaded. You must configure the basic settings of the Webcache by 
completing the Getting Started wizard before you introduce the 
Webcache to your live network. For more information, see “Getting 
Started Wizard Settings” on page 43.

Setting Up Using the
Command Line

Interface

You can setup the Webcache for management via the Command Line 
Interface by running a Telnet session on a management workstation that 
is connected to the Webcache over your test network, or locally via a 
console port connection.

Setting Up Over the Test Network

The Webcache is pre-configured with a default IP address, which is within 
the range of addresses reserved by the IETF for private IP networks. This 
default address allows you to run the Command Line Interface without 
any initial configuration of IP addresses. The default IP address of the 
Webcache is 192.168.1.253.

Figure 15   Setting Up Over the Test Network
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To setup the Webcache using the Command Line Interface over a test 
network using Telnet, open a Telnet session using a terminal emulator by 
specifying the IP address of the Webcache. If you are unsure how to do 
this, check the documentation supplied with the Telnet facility

To connect the Webcache to the test network:

� The client machine must be in the same subnet as the Webcache to be 
able to access it using the default IP address.

� You must have an IP stack correctly installed on the client machine. 
You can check this by trying to browse the World Wide Web; if you 
can browse, an IP stack is installed. If you do not have access to the 
World Wide Web, you can check that the IP stack is installed by 
pinging another device in your network. For more information, see 
“Pinging Other Devices” on page 91.

Setting Up Through the Console Port

Alternatively, you can directly connect a client machine to the Webcache 
by attaching a null-modem cable to the console port on the rear panel. 
For more information, see “Webcache — Rear View Detail” on page 20.

Figure 16   Setting Up Through the Console Port

To connect to the Webcache via the console port:

1 You must connect a terminal or terminal emulator to the console port on 
the rear panel of the Webcache. For more information, see “Webcache 
— Rear View Detail” on page 20.

� If you are connecting directly to the console port, you need a standard 
null-modem cable.

� If you are connecting to the console port using a modem, you need a 
standard modem cable. The console port of the Webcache has a male 
9-pin D-type connector. You can find pin-out diagrams for both cables 
in the “Cable Specifications and Pin-outs” appendix on page 147.

To connect the cable:

a Attach the female connector on the cable to the male connector on 
the console port of the Webcache.
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b Tighten the retaining screws on the cable to prevent it from being 
loosened.

c Connect the other end of the cable to your terminal, terminal 
emulator, or modem. Make sure that the terminal, terminal emulator, 
or modem have the same settings as the console port: 

� 8 data bits

� no parity

� 1 stop bit

2 To configure the settings of the terminal, terminal emulator, or modem, 
see the documentation that accompanies it. You must configure the 
terminal and set the line speed (baud) to 9600. You can change the baud 
rate of the console port via the Web interface.

Accessing the Command Line Interface

To access the Command Line Interface, take the following steps:

1 The login sequence for the Command Line Interface begins as soon as 
the Webcache detects a connection to its console port, or as soon as a 
Telnet session is started.

If the login sequence does not begin immediately, press Return a few 
times until it does begin. If the sequence still does not begin, see “Solving 
Command Line Interface Problems” on page 133.

2 At the Login and Password prompts, enter your user name and password. 
For further information, see “Logging in as a Default User” on page 58.

3 If you have logged on correctly, the Top-level menu of the Command Line 
Interface is displayed as described in “Understanding the Command Line 
Interface” on page 112. If you have not logged on correctly, the message 
Incorrect password. is displayed and the login sequence starts again.

4 Access the Getting Started wizard, which allows you to quickly configure 
the basic setup information for the Webcache.

At the Top-level menu, enter:

gettingStarted

5 The Getting Started wizard is displayed. You must configure the basic 
settings of the Webcache by completing the Getting Started wizard 
before you introduce the Webcache to your live network. For more 
information, see “Getting Started Wizard Settings” below.
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Getting Started 
Wizard Settings

The following table shows the settings that you can configure in both the 
Web interface and Command Line Interface Getting Started wizards.

CAUTION: You must configure the basic settings of the Webcache by 
completing the Getting Started wizard before you introduce the 
Webcache to your live network. In particular, ensure that the IP settings 
of the Webcache fit into those of your network.

Table 8   Getting Started wizard Settings

Setting Meaning Default Example

System Name A name that uniquely identifies the 
Webcache in your network. Can be up to 
255 characters long.

(none) Webcache 3000 #1

Location A description that identifies the location of 
the Webcache in your network. Can be up 
to 255 characters long.

(none) Main server room

Contact The name of the person who is responsible 
for the Webcache. Can be up to 255 
characters long.

(none) Joe Brown

IP Address A unique IP address for the Webcache. 192.168.1.253 192.168.1.253

Subnet Mask A suitable Subnet Mask for the Webcache. (none) 255.255.255.0

Default Router IP Address The IP address of the default IP router 
(gateway) in your network.

(none) 192.168.2.0

DNS Server IP Address The IP address of the Domain Name System 
(DNS) server in your network.

(none) 192.168.25.0

Host Name The Host Name is combined with the DNS 
Domain Name to give the internet name of 
the Webcache. The host name is the name 
of the Webcache within the local domain.

(none) webcache

Domain Name System 
(DNS) Domain Name

The DNS Domain Name is combined with 
the Host Name to give the internet name of 
the Webcache. The Domain Name is a 
grouping of computers with related 
properties.

(none) mycompany.com

Timezone The timezone in which the Webcache will 
operate.

(GMT - 05:00) 
Eastern Time (US)

(GMT) London, 
Dublin, Edinburgh

NTP Server IP Address The IP address of a Network Time Protocol 
server.

(none) 200.49.40.1

Current Date The current day, month and year. (none) 06 March 2001

Current Time The current time in 24hr clock format. (none) 12:15:45

(continued)
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Connecting the 
Webcache to the 
Live Network

The following sections describe how to connect the Webcache to your 
live network.

Choosing the Correct
Cables

3Com recommends that you use Category 5 cable to connect the LAN 
port to your network — the maximum segment length for this type of 
cable is 100 m (328 ft).

Connecting the
Webcache

Use the following sequence of steps to connect the Webcache to your 
network:

1 Connect an appropriate network cable to the LAN port on the rear panel 
of the Webcache. Simply slot the connector on the cable into the RJ-45 
LAN port. When the connector is fully in, its latch locks in place. To 
disconnect the cable, push the connector’s latch in and remove it.

2 Connect the other end of the network cable to a 10BASE-T/100BASE-TX 
port on a suitable switch or hub in your network. The switch or hub that 
you connect the Webcache to is determined by the deployment 
environment that you choose; for further information, see “Deploying 
the Webcache in Your Network” on page 33.

Password A password for the admin user name, which 
you must enter whenever you manage the 
Webcache via the Web interface or 
Command Line Interface. Can be up to 10 
characters long, is case-sensitive and must 
only contain alpha-numeric characters.

(no password) 1a2b3c4d4e

Caching Mode Choose how the Webcache is deployed 
within your network - either Proxy Mode or 
Transparent Mode.

Proxy Mode N/A

Caching Port Number The port number on which the Webcache 
will listen for traffic. This is only required if 
you set the Caching Mode to “Proxy Mode”. 
You may use any other numbers in the 
range 1024-8080 and 8090-65534. 3Com 
recommends you use the default port 
number of 8080.

8080 8080

Setting Meaning Default Example
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Network 
Configuration 
Concepts

The following sections explain certain key concepts of configuring your 
network, which you must understand in order to set up the Webcache 
successfully.

IP Addresses If you are uncertain about what IP addresses to assign your equipment, 
contact your network administrator.

To operate correctly, each device on your network (for example a 
webcache or management station) must have a unique IP address. IP 
addresses have the format nnn.nnn.nnn.nnn where n is a decimal 
number between 0 and 255. An example IP address is ‘192.168.100.8’.

The IP address can be split into two parts:

� The first part (‘192.168’ in the example) identifies the network on 
which the device resides.

� The second part (‘100.8’ in the example) identifies the device within 
the network.

If your network is internal to your organization only, you may use any 
arbitrary IP address. We suggest you use addresses in the series 
192.168.100.X (where X is a number between 1 and 254) with a subnet 
mask of 255.255.255.0.

These suggested IP addresses are part of a group of IP addresses that 
have been set aside specially for use “in house” only.

CAUTION: If your network has a connection to the external IP network, 
you must apply for a registered IP address. This registration system 
ensures that every IP address used is unique; if you do not have a 
registered IP address, you may be using an identical address to someone 
else and your network will not operate correctly.

Obtaining a Registered IP Address

InterNIC Registration Services is the organization responsible for 
supplying registered IP addresses. The following contact information is 
correct at time of publication:

World Wide Web site: http://www.internic.net
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Subnets and Using a
Subnet Mask

You can divide your IP network into sub-networks also known as subnets. 
Support for subnets is important because the number of bits assigned to 
the device part of an IP address limits the number of devices that may be 
addressed on any given network. For example, a Class C address is 
restricted to 254 devices.

If you have a small network (less than 254 devices), you may decide not 
to have multiple subnets.

A subnet mask is used to divide the device part of the IP address into two 
further parts:

� The first part identifies the subnet number.

� The second part identifies the device on that subnet.

The bits of the subnet mask are set to 1 if the device is to treat the 
corresponding bit in the IP address as part of the original network 
number or as part of the subnet number. These bits in the mask are set to 
0 if the device is to treat the bit as part of the device number.

If you are unsure about what mask to use, 3Com suggest that you 
contact your network administrator.

Default Router A Router is a device on your network which is used to forward IP packets 
to a remote destination. An alternative name for a Router is a Gateway. 
“Remote” refers to a destination device that is not directly attached to 
the same network segment as the source device. 

The source device cannot send IP packets directly to the destination 
device because it is in a different network segment. Instead you configure 
it to send the packets to a router which is attached to multiple segments.

When it receives the IP packets, the router determines the next network 
hop on the path to the remote destination, and sends the packets to that 
hop. This could either be the remote destination or another router closer 
towards the destination. 

This hop-by-hop process continues until the IP packets reach the remote 
destination.

To configure the Webcache, enter the IP address of the default router on 
the local subnet in which the Webcache is located. If no default router 
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exists on your network, enter the IP address 0.0.0.0 or leave the field 
blank. 

If you set the default router to 0.0.0.0 or leave it blank, the Webcache 
will only be able to access devices that are in the same subnet as the 
Webcache.

Domain Name System The Domain Name System (DNS) maps a numerical Internet Protocol (IP) 
address to a more meaningful and easy-to-remember name. When you 
need to access another device on your network, you enter the name of 
the device, instead of its IP address. A Domain Name System server on 
your network is contacted and asked the electronic form of the question, 
“What is the IP address of the destination device?”. The DNS server is a 
machine that keeps track of all the names and their equivalent numeric IP 
addresses. The DNS server responds with the correct IP address (e.g. 
128.118.2.23), allowing the two devices to communicate with each 
other.

To enable the Domain Name System, you must setup a DNS server on 
your network. If you are uncertain about how to do this, contact your 
network administrator.

The following Webcache features are only available if you have setup a 
DNS server:

� Access to the Webcache by DNS Name — You can access the Web 
interface or Command Line Interface of the Webcache via its DNS 
name, rather than its IP address e.g. webcache.mycompany.com.

� Web Proxy Auto-Discovery — This protocol can be used to 
configure Web browsers on client machines in a Proxy Cache 
deployment. For further information, see “Web Proxy Auto-Discovery 
(WPAD)” on page 53.

Domain Name System
Syntax

You must use the following syntax for the Domain Name System host 
name and domain name:

� Host Name

� The host name must be at least 1 character long.

� The host name must not exceed 63 characters long.

� The host name must be comprised of alphanumeric characters, - 
(hyphens) and _ (underscores).
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� You cannot enter a host name starting or ending with a . (dot) 
character. It must start and end with a letter or number.

� You cannot enter a host name containing a space character.

� Domain Name

� The domain name must be at least 1 character long.

� The domain name must not exceed 63 characters long.

� The domain name must be comprised of alphanumeric characters, 
- (hyphens) and _ (underscores).

� You cannot enter a domain name starting or ending with a . (dot) 
character. It must start and end with a letter or number.

� Each part of the domain name (known as a label) must be 
separated with a . (single dot).

� You cannot enter a domain name which has two . (dots) next to each 
other.
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 CONFIGURING WEB BROWSERS
This chapter contains information about configuring Web browsers on 
client machines for use in a Webcache proxy cache deployment. It covers 
the following alternative methods:

� Manual Configuration

� Proxy Auto Configuration (PAC) File Scripts

� Web Proxy Auto-Discovery (WPAD)

� Third-party Tools

For more information about Proxy Cache deployment, see “Proxy Cache” 
on page 33.

No configuration of Web browsers on client machines is required for a 
Webcache transparent cache deployment; for more information, see 
“Transparent Cache” on page 34.

Manual 
Configuration

You can manually configure the Web browser on each client machine to 
explicitly direct its Web requests to the Webcache.

To manually configure Internet Explorer 5:

1 Open Internet Explorer.

2 From the Tools menu, click Internet Options.

3 Click the Connections tab.

4 Click LAN Settings.

5 Tick Use a proxy server.

6 Enter the URL or location of the Webcache in the Address field.

7 Enter the caching port number on which the Webcache is listening in the 
Port field. The default port number is 8080.
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You can view the port number for the Webcache by:

a Logging into the Web Interface.

b Selecting Device View -> System -> Caching -> Set Caching Mode.

8 Click OK.

To manually configure Netscape Navigator 4.5:

1 Open Netscape Navigator.

2 From the Edit menu, click Preferences.

3 Click the Advanced category and click Proxies.

4 Select Manual Proxy Configuration.

5 Click View.

6 Enter the URL or location of the Webcache in the HTTP, Security and FTP 
fields.

7 Enter the caching port number on which the Webcache is listening in 
each Port field. The default port number is 8080.

8 Click OK.

3Com recommends that you configure the client machine that you use to 
manage the Webcache so that it does not use the Webcache as a proxy 
server. In Internet Explorer, select Tools -> Internet Options -> 
Connections -> LAN Settings and disable Use a Proxy Server. In Netscape, 
select Edit -> Preferences -> Advanced -> Proxies and select Direct 
Connection to the Internet.

Proxy Auto 
Configuration (PAC) 
File Scripts

You can use a Proxy Auto Configuration (PAC) file to configure the Web 
browser on each client machine. PAC files allow you to create 
configuration rules that determine how the Web browser operates when 
the Webcache is being deployed as a Proxy cache. The PAC file can be 
stored either on the Webcache or a network server, and the Web browser 
is set to read the PAC file when it is opened.

The main disadvantage of PAC files is that the PAC file is read once when 
the Web browser is first opened, and then executed within the browser 
for every object within every Web page visited. This can cause a perceived 
response time degradation, although the performance degradation is 
likely to be small.
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You can only use a PAC file to configure the Web browsers on client 
machines when the Webcache is operating in Proxy mode.

You can use the Browser Auto-Configuration screen to create a PAC file 
which is stored on the Webcache. You can configure the PAC file to:

� Bypass the Webcache for plain host names

� Use a backup Webcache if the first one fails

� Directly access the Web if neither the first or second Webcache is 
available

Alternatively, you can disable the PAC file that the Webcache creates and 
use a different PAC file which is located elsewhere on your network.

CAUTION: If you are using Browser Auto-Configuration Files to configure 
your client machine Web browser settings, and you are using Web Client 
Blocking to control access to the Internet, you should ensure that Go 
Direct if no Webcache Available is not ticked in the Browser 
Auto-Configuration screen. If this box is ticked, the Web browser will 
bypass the Webcache entirely after reading the Browser 
Auto-Configuration file, and will never be blocked.

To use the Webcache as a PAC file server, first configure the Webcache 
PAC file using the Browser Autoconfiguration screen:

1 Log in to the Web interface.

2 Click Device View on the Toolbar.

3 Select System -> Caching -> Browser Auto-Config in the Navigation 
Tree.

4 Tick Bypass Plain Host Names if you want to configure Web browsers to 
bypass the Webcache for plain host names. These are typically domain 
names which do not contain dots, commonly used for Intranet sites e.g. 
http://intranet

5 Tick Use Backup Cache on Cache Failure if you want to configure Web 
browsers to use an alternative Webcache in your network if the first one 
fails. Enter the IP address of the alternative Webcache in the Backup 
Cache IP Address field. Enter the port number on which the Webcache 
will be listening for network traffic in the Port field. The default port 
number is 8080.
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6 Tick Go Direct if no Webcache Available if you want to configure Web 
browsers to directly access the Web if the main and backup Webcaches 
fail. Click OK.

You must next set the Web browser to read the PAC file for its settings.

To set Internet Explorer 5:

1 Open Internet Explorer.

2 From the Tools menu, click Internet Options.

3 Click the Connections tab.

4 Click LAN Settings.

5 Tick Use automatic configuration script.

6 Enter the URL or location of the Webcache in the Address field in the 
following format:

http://nnn.nnn.nnn.nnn:8082/

where nnn is a decimal number between 0 and 255. An example IP 
address is ‘192.168.1.253’. The port number on which the Webcache 
always serves PAC files is 8082; you cannot change this port number.

7 Click OK.

To set Netscape Navigator 4.5:

1 Open Netscape Navigator.

2 From the Edit menu, click Preferences.

3 Click the Advanced category and click Proxies.

4 Select Automatic Proxy Configuration.

5 Enter the URL or location of the Webcache in the Configuration location 
field in the following format

http://nnn.nnn.nnn.nnn:8082/

where nnn is a decimal number between 0 and 255. An example IP 
address is ‘192.168.1.253’.

In Netscape, you can enter a shortened PAC address such as 
webcache:8082 and Netscape successfully configures itself using the PAC 
file. In Internet Explorer, however, this address is not recognized and you 
are not warned that the PAC file is being ignored. You must include 
"http://" at the start of the URL i.e. http://webcache:8082.
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6 Click Reload.

7 Click OK.

Web Proxy 
Auto-Discovery 
(WPAD)

The Webcache and Microsoft Internet Explorer 5 (and later versions) 
support the Web Proxy Auto-Discovery (WPAD) protocol. This protocol 
enables the Web browser on client machines to automatically find and 
load proxy configuration information (stored in a PAC file) from a server 
on your network without user intervention.

You cannot set up the 3Com Webcache to be used as a WPAD server.

The Web Proxy Auto-Discovery (WPAD) protocol is not supported by 
Netscape Navigator.

You can set up a WPAD server that holds a PAC file in a suitable domain 
on your network. When Internet Explorer 5 is launched it searches for a 
WPAD server. The Web browser adds the subdomain “wpad” to the 
beginning of the fully-qualified domain name and progressively removes 
subdomains until it either finds a WPAD server answering the domain 
name or reaches the third-level domain. For example, Web browsers on 
client machines in the a.b.3Com.com domain would query 
wpad.a.b.3Com, wpad.b.3Com.com, and then wpad.3Com.com. If a 
WPAD server is found, the Web browser downloads and executes the 
PAC file and configures the browser settings.

You must define your network Domain Name System (DNS) server with 
the appropriate use of domains in order to use a WPAD server. For further 
information about the Domain Name System, see “Domain Name 
System” on page 47.

When a Web browser on a client machine is configured to use a WPAD 
server on your network, there may be a pause of several seconds when it 
first tries to connect to the server. The delay is caused by the Web 
browser connecting to your Domain Name System (DNS) server when it is 
initially started. This is normal behavior. Once the Web browser has 
accessed the WPAD server, subsequent browser requests will operate 
without delays caused by WPAD.
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To configure Internet Explorer 5 to use WPAD:

1 Open Internet Explorer.

2 From the Tools menu, click Internet Options.

3 Click the Connections tab.

4 Click LAN Settings.

5 Tick Automatically detect settings.

6 Click OK.

Web Proxy
Auto-Discovery

Resources

You can view the Internet Draft for the Web Proxy Auto-Discovery 
Protocol at:

http://www.ietf.org/internet-drafts/draft-cooper-webi-wpad-0

0.txt

(correct at time of publishing)

Third-party Tools There are applications from many vendors that can help you to manage 
networks of client machines. 

Microsoft offers the Internet Explorer Administration Kit and Systems 
Management Server, which allow you to remotely configure Web 
browsers and Proxy Cache settings.

http://www.microsoft.com/windows/ieak/en/default.asp

Other vendors include Hewlett Packard, Intel and Tivoli.
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4
 MANAGING THE WEBCACHE
This chapter contains information about managing the Webcache using 
the management software that resides on the Webcache. Managing the 
Webcache can help you to improve the efficiency of the Webcache and 
therefore the overall performance of your network. It allows you to make 
full use of the features offered by the Webcache, and to change and 
monitor the way it works. The following topics are covered:

� Management Software Interfaces

� Logging in as a Default User

� Accessing the Web Interface

� Understanding the Web Interface

� The Banner

� The Toolbar

� The Navigation Tree

� The Information Area

Management 
Software Interfaces

You can manage the Webcache using the Web interface management 
software. This is an internal set of Web pages that allow you to manage the 
Webcache using a Web browser that has Javascript™ enabled. Refer to the 
Webcache Online Help for detailed information about the Web interface.

The Webcache also has a Command Line Interface that allows you to 
manage certain features; for more information, see the “Command Line 
Interface” chapter on page 109.

Even if you do not intend to actively manage the Webcache, 3Com 
recommends that you change the default password to prevent 
unauthorized access to your Webcache. See “Setting Passwords” on 
page 71 for more information.
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Logging in as a 
Default User

If you manage the Webcache using the Web interface or the Command 
Line Interface, you need to log in with a valid user name and password.

The Webcache has one user name, which is listed in Table 9. You cannot 
create new user names for the Webcache.

Table 9   User Names

CAUTION: To prevent unauthorized access and configuration of the 
Webcache, 3Com recommends that you set a password for the admin 
user name as soon as possible.

The admin user name is case-sensitive.

Accessing the Web 
Interface

To access the Web interface:

1 Open the Web browser on the management workstation. To display the 
Web interface correctly, use one of the following Web browsers:

� Microsoft Internet Explorer v4.0

� Microsoft Internet Explorer v5.0

� Microsoft Internet Explorer v5.5

� Netscape Communicator v4.5

� Netscape Communicator v4.6

� Netscape Communicator v4.7

Netscape Navigator version 6 is not supported by the Webcache.

For the browser to operate the Web interface correctly JavaScript and 
Cascading Style Sheets must be enabled on your browser. These features 
are enabled on a browser by default. You will only need to enable them if 
you have changed your browser settings. Also the Web interface has 

User name
Default
Password Access Level

admin (no password) The user can access and change all manageable 
parameters
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been optimized for PC screens with the desktop area set to 800 by 600 
pixels. It is also recommended to set the font size to Small Fonts.

2 In the Location/Address field of the browser, enter the URL of the 
Webcache. This must be in the format:

http://nnn.nnn.nnn.nnn:8081

where nnn.nnn.nnn.nnn is the IP address of the Webcache and 8081 is 
the port on which the Webcache listens. You must enter http:// and the 
port number to successfully access the Webcache using your browser.

192.168.1.253 is the default IP address of the Webcache.

In Netscape, you can enter a shortened URL such as 192.168.1.253:8081 
and Netscape successfully accesses the Webcache. In Internet Explorer, 
however, this URL is not recognized. You must include "http://" at the 
start of the URL i.e. http://192.168.1.253:8081.

3 When the browser has located the Webcache, a user name and password 
screen is displayed as shown in Figure 17.

Figure 17   User Name and Password Screen

If the user name and password screen is not displayed, see “Solving Web 
Interface Problems” on page 130.

4 Enter your user name and password. For further information, see 
“Logging in as a Default User” on page 58. Click OK.
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Understanding the 
Web Interface

Figure 18   The Web Interface

The Web interface is made up of four areas:

� The Banner

This is always displayed at the top of the browser window. It displays 
the 3Com logo and SuperStack® logo.

� The Toolbar

This is always displayed at the top of the browser window, underneath 
the Banner. It contains three buttons which allow you to select 
different views in the View Area.

� The Navigation Tree

This is always displayed on the left side of the browser window. It 
contains various icons which allow you to manage your Webcache.

� The Information Area

This is always displayed on the right side of the browser window. It 
contains information about the managed Webcache.

The Banner The Banner is always displayed at the top of the browser window. It 
displays the 3Com logo and SuperStack logo.
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The Toolbar The Toolbar is always displayed at the top of the browser window, 
underneath the Banner. It contains three buttons which allow you to 
select different views:

� The Summary View

Click Summary to display the Summary View. This view allows you to 
update the latest summary information for the Webcache.

� The Device View

Click Device View to display the Device View. This view allows you to 
configure the physical and networking aspects of the Webcache.

� The Help View

Click Help to display the Help View. This view allows you to access the 
Online Help system for the Webcache, additional information from the 
3Com Web site and provides specification guidelines for running the 
Web interface.

The Summary View Click Summary on the Toolbar to access the Summary View. This is the 
default view when you first browse to the Webcache and when you click 
the browser Refresh button.

Click the System icon in the Navigation Tree to update the Information 
Area with the latest summary information for the Webcache.

The summary information is displayed in a table:

� Device Summary

The table is entitled System Summary and displays information for the 
Webcache. It shows the System Name, Location, Contact, Up Time, 
Type, Software Version, Hardware Version and IP Address of the 
Webcache.

The Summary View only displays information for the Webcache. You 
cannot perform any operations from this view. You must use the Device 
View to perform operations.

The Device View Click Device View on the Toolbar to access the Device View. This view 
allows you to configure the physical and networking aspects of the 
Webcache.
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The Device View Navigation Tree is displayed on the left side of the 
browser window and allows you to perform operations for the 
Webcache.

The Device View Information area is displayed on the right side of the 
browser and contains the device mimic and the Device Summary table.

Device Mimic

Figure 19   The Device Mimic

The device mimic is a virtual, interactive representation of the Webcache. 
All of the ports on the Webcache are shown, even though the LAN, WAN 
and Console ports are actually located on the rear of the unit. The device 
mimic is periodically updated to reflect changes in the Webcache. You 
can also perform certain operations by clicking on parts of the device 
mimic called “hotspots”:

� Console Port Hotspot

The Console Port on the mimic is a “hotspot”. Click the port to open 
a pop-up menu that contains an operation which you can launch for 
the console port.

The operation is Setup Console Port.

� LAN Port Hotspot

The LAN Port on the mimic is a “hotspot”. Click the port to open a 
pop-up menu that contains an operation which you can launch for the 
LAN port.

The operation is Clear Cache.

� Unit Hotspot

The non-port area of the mimic is a “hotspot”. Click anywhere on this 
area to open a pop-up menu that contains operations which you can 
launch for the Webcache as a whole.

The operations are:
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� Web Client Blocking

� Web Site Blocking

� Save Configuration

� Notepad

� System Information

Device Summary

A table entitled Device Summary displays the following information for 
the Webcache. It shows the DNS Name, Type, Software Version, 
Hardware Version, IP Address, MAC Address, Boot Version, Product 
Number, Serial Number and Up Time of the Webcache.

The Help View Click Help on the Toolbar to access the Help View. This view allows you to 
access the Online Help system for the Webcache, additional information 
from the 3Com Web site and provides specification guidelines for 
running the Web interface.

The Help View Navigation Tree contains five options that allow you to 
access additional information from the 3Com Web site. Your 
management workstation must have access to the Web for the first four 
options to work:

� Click Contacts to display contact information from the 3Com Web site 
in a new browser window.

� Click Home Page to display the Home page of the 3Com Web site in a 
new browser window.

� Click Library to display the Online Library of the 3Com Web site in a 
new browser window.

� Click Support to display support information from the 3Com Web site 
in a new browser window.

� Click On-line Help to display the Webcache Online Help system in a 
new browser window.

The Help View Information Area provides specification guidelines for 
running the Web interface. It is recommended that you access the Web 
Interface using the suggested Web Browsers and PC Platforms.
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The Navigation Tree The Navigation Tree is always displayed on the left side of the browser 
window. It is a Windows® Explorer-like interface that contains various 
icons which allow you to manage your Webcache.

By default, when you open the Web interface, the Summary View is 
selected and the Navigation Tree is fully collapsed with only the top-level 
options displayed.

Operations that you can perform to manage your Webcache are grouped 
into folders within the Navigation Tree in the Device View. You can also 
perform some operations by using the device mimic.

Click the folders or the nodes (the plus and minus symbols) to expand 
and collapse the Navigation Tree.

Every option within the Navigation Tree is selected by single-clicking the 
left mouse button.

The following table shows the various Navigation Tree symbols and their 
associated behavior:

Symbol Behavior

Indicates that the next level of the Navigation Tree hierarchy is currently expanded. Click the 
symbol to collapse the next level. This only affects the Navigation Tree — no changes are 
made to the Information Area.

Indicates that the next level of the Navigation Tree hierarchy is currently collapsed. Click the 
symbol to expand the next level to its last expanded state. This only affects the Navigation 
Tree — no changes are made to the Information Area.

Indicates that the next level of the Navigation Tree hierarchy is currently expanded. Click the 
symbol to collapse the next level. This only affects the Navigation Tree — no changes are 
made to the Information Area.

Indicates that the next level of the Navigation Tree hierarchy is currently collapsed. Click the 
symbol to expand the next level. This only affects the Navigation Tree — no changes are 
made to the Information Area.

(continued)



The Information Area 65
The Information 
Area

The Information Area is always displayed on the right side of the browser 
window. It contains information about the managed Webcache.

If the Summary View is currently selected, a table is displayed which 
shows summary information for the Webcache.

If the Device View is currently selected, the Device Mimic and the Device 
Summary table are displayed.

If the Help View is currently selected, specification guidelines for running 
the Web interface are displayed.

Click the symbol to update the Information Area with the latest summary information for the 
Stack and the units within it. This symbol is only available in the Summary View.

Click the symbol to perform an operation by opening a new window.

Click the symbol to open a wizard in a new window.

Click the symbol to launch a Help operation.

Symbol Behavior
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5
 SYSTEM TIME
This chapter explains how to configure the system time of the Webcache. 
It contains the following topics:

� Configuring the System Time

� What is the Network Time Protocol?

� Choosing a Network Time Protocol Server

� Configuring the System Time Using the Network Time Protocol

� Configuring the System Time Manually

� System Time and Performance Graphs

Configuring the 
System Time

You must select how the Webcache determines the current time during 
the Getting Started wizard, which automatically runs when you first 
access the Webcache’s Web interface.

You can change how the Webcache determines the current time at any 
point using the Time Configuration wizard. Select System -> 
Management -> Time Configuration in the Navigation Tree to access 
the wizard.

You can configure the system time in either of the following ways:

� Configuring the System Time Using the Network Time Protocol — for 
more information, see page 69

� Configuring the System Time Manually — for more information, see 
page 69.

3Com recommends that you use the Network Time Protocol to configure 
the system time of the Webcache.
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What is the 
Network Time 
Protocol?

The Network Time Protocol (NTP) is used to synchronize the time of client 
machines and servers with other well-known, highly accurate servers or 
reference time sources. It maintains a consistent Coordinated Universal 
Time (UTC) within your network which is far more accurate than the 
internal system clocks of client machines and prevents time drift from 
occurring on the Webcache.

NTP provides client machine and server time accuracies typically within a 
millisecond on LANs, relative to a primary NTP server synchronized to UTC 
via a Global Positioning Service (GPS) receiver. Such accurate 
time-keeping is an essential part of the operation of the Webcache.

Choosing a 
Network Time 
Protocol Server

You can choose to use one of the many public NTP servers that are 
available on the Internet or set up your own NTP server. When you have 
access to an NTP server, you can configure the Webcache to determine 
the current time using NTP; see “Configuring the System Time Using the 
Network Time Protocol” on page 69 for more information.

Public NTP servers are grouped into stratums. The NTP primary (stratum 1) 
servers are connected to a reference clock, which is typically an expensive 
cesium clock or cheaper GPS receiver. Servers operating at stratum 1 are 
the most accurate available, but also the fewest in number because of 
the prohibitive cost of reference clocks.

The NTP secondary (stratum 2) servers are in turn connected to a stratum 
1 server and are therefore less accurate but greater in number. Stratum 3 
servers are connected to stratum 2 servers, and so on, up to an imposed 
limit of 15 strata. You should not use a high level public stratum server 
because of their limited number and because the load placed on them is 
increasingly heavy.

3Com recommends that if your network has an internal NTP server, you 
should use this rather than a public stratum server. If not, you should use 
the lowest stratum public NTP server available to you.
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Configuring the 
System Time Using 
the Network Time 
Protocol

To configure the system time of the Webcache using the Network Time 
Protocol, you must enter the following information in the Getting Started 
wizard or Time Configuration command in the Web interface:

1 Select a timezone from the options in the Timezone drop-down list.

The Webcache automatically performs daylight savings adjustments 
according to the timezone that you have selected.

2 Choose Network Time Protocol by clicking the appropriate radio button.

3 Enter the IP address of the NTP server that you want to use in the NTP 
Server IP Address field.

Configuring the 
System Time 
Manually

To manually configure the system time of the Webcache, you must enter 
the following information in the Getting Started wizard or Time 
Configuration command in the Web interface:

1 Select a timezone from the options in the Timezone drop-down list.

The Webcache automatically performs daylight savings adjustments 
according to the timezone that you have selected.

2 Choose Manual Time Configuration by clicking the appropriate radio 
button.

3 Enter the current day, month, year and the current time (in 24 hour clock 
format) in the appropriate fields.

4 Click Apply Now as soon as you have manually entered this information 
to ensure the greatest accuracy. You cannot click Next until you have 
done this.

System Time and 
Performance 
Graphs

When the system time of the Webcache is set manually, all of the current 
Performance Graphs are reset and all previous graph history is lost. You 
should therefore only change the system time when it is absolutely 
necessary. The following system time changes affect the Performance 
Graphs in this way:

� The system time is manually configured.

� The system time is changed from Network Time Protocol to Manual 
Time Configuration, or vice versa.

� The IP address of the Network Time Protocol server is changed.
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A Warning window appears asking if you want to continue with the 
system time change. Click Yes to continue and reset the Performance 
Graphs, or No to cancel the change.
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 SECURITY
This chapter contains information about ensuring that the Webcache 
1000/3000 is secure. It covers the following topics:

� What are Passwords?

� Setting Passwords

� What is Password Recovery?

� Enabling/Disabling Password Recovery

� Performing Password Recovery

What are 
Passwords?

Whenever you manage the Webcache using the Web interface or 
Command Line Interface, you need to log in with the admin username 
and password, as described in “Logging in as a Default User” on 
page 58.

CAUTION: To prevent unauthorized access and configuration of the 
Webcache, 3Com recommends that you set a password for the admin 
username as soon as possible.

Setting Passwords To set the password using the Web interface, you need to login as the 
admin user and select Security -> Set Password in the Navigation Tree 
to access the Password Configuration screen. Then follow the steps 
below.

You are prompted to set a password for the admin user account during 
the Getting Started wizard, which automatically runs when you first 
access the Webcache’s Web interface.
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You must enter the following information in both the Getting Started 
wizard and the Password Configuration screen:

1 Choose between the following options by clicking the appropriate radio 
button:

� Do Not Change Password

� Change Password for the Account

� Set Admin Password to the Factory Default Setting

2 Either:

� If you choose Do Not Change Password, the existing password will not 
be changed.

� If you choose Change Password for the Account, enter a new 
password in the Password field and enter it again in the Confirm field.

Passwords can be up to 10 characters long, are case-sensitive and must 
only contain alpha-numeric characters.

� If you choose Set Admin Password to the Factory Default Setting, the 
password is automatically set to the default for the admin user 
account (no password).

What is Password 
Recovery?

If you forget the password for the admin user account, you will no longer 
be able to perform important management operations on the Webcache. 
Password Recovery allows you to define a new password for the admin 
account, even though you have forgotten the current one, and regain 
access to the management interfaces.

Enabling/Disabling 
Password Recovery

In order to perform password recovery, Password Recovery must be 
enabled on the Webcache.

Password Recovery is enabled by default on the Webcache. You will only 
need to complete the following steps if you want to check that password 
recovery is enabled, or if you know that it has previously been disabled.

You may want to disable password recovery if you are concerned about 
the security of the Webcache. When password recovery is enabled, 
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anyone who has physical access to the Webcache can potentially change 
the password and lock you out of the management interfaces.

CAUTION: 3Com recommends that you leave Password Recovery 
enabled. If you disable it and subsequently forget the password for the 
admin username, you will have to return the Webcache to 3Com.

To enable or disable Password Recovery using the Web interface:

1 Log in to the Web interface.

2 Click Device View on the Toolbar.

3 Select Security -> Recovery in the Navigation Tree. The 
Password Recovery screen is displayed.

4 Check Enable Password Recovery Feature to enable Password Recovery, 
or uncheck Enable Password Recovery Feature to disable it.

5 Click OK.

Performing 
Password Recovery

Use the password recovery method outlined below to define a new 
password for the admin username:

1 Access the Command Line Interface and enter the username “recover” 
and password “recover” to place the Webcache in password recovery 
mode. The Webcache remains in password recovery mode for a 
maximum of 30 seconds, before it returns to the CLI login prompt.

2 Reboot the Webcache whilst it is in password recovery mode by removing 
the power cord from the power socket at the rear of the Webcache and 
reinserting it.

3Com recommends that you access the CLI in this instance by connecting 
a standard null-modem cable to the console port on the Webcache. This 
enables you to be physically close enough to the Webcache to reboot the 
Webcache before password recovery mode resets.

You cannot use a soft reboot operation to reset the password of the 
admin username. This will end the password recovery procedure and 
return you to the CLI login prompt.

3 When the Webcache has rebooted enter a new password for the admin 
username.

4 Enter enable to leave password recovery enabled, or enter disable to 
turn it off. You are now logged in as the default admin user.
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 CONTROLLING AND MONITORING 
WEB ACCESS
This chapter contains information about controlling the access of the 
users of your network through the Webcache to the Internet. It covers 
the following topics:

� What is Web Site Blocking?

� Configuring Web Site Blocking

� Customizing the Response

� What is Web Client Blocking?

� Configuring Web Client Blocking

� What is Access Logging?

� Configuring Access Logging

� Viewing the Access Log

� Analyzing the Access Logs

What is Web Site 
Blocking?

Web Site Blocking allows you to control which Web sites can be accessed 
through the Webcache. If you enable web site blocking, you can enter 
the domain names of Web sites that you want to either allow or deny 
access to. You can specify one of two blanket rules with exceptions; 
either “Deny access to all sites except...” the ones that you enter, or 
“Allow access to all sites except...” the ones that you enter. Web requests 
from client machines will then either be served or blocked by the 
Webcache, according to the rules that you have set up. A customizable, 
automatically generated Web page informs the end user that access to 
the Web site has been denied.



76 CHAPTER 7: CONTROLLING AND MONITORING WEB ACCESS
Configuring Web 
Site Blocking

To configure Web Site Blocking using the Web interface:

1 Log in to the Web interface.

2 Click Device View on the Toolbar.

3 Select System -> Caching -> Web Site Blocking in the Navigation Tree.

4 Check Enable Web Site Blocking.

5 Select Deny Access to All Sites to deny access to all Web sites except the 
ones that you enter in the list, or select Enable Access to All Sites to allow 
access to all Web sites except those listed.

6 In the Except the Following field, enter the domain name of the Web site 
you want to exclude from the option you chose in step 5 and click Add. 
Repeat this for each Web site that you want to block.

Example

You can enter yahoo.com to block access to that entire domain, or enter 
auctions.yahoo.com to block access to that subdomain.

Domain Name Rules

� You cannot enter a domain starting with http:.

� You cannot enter a domain containing the / (forward slash) character.

� You cannot enter a domain containing a space character.

� You cannot enter a domain starting or ending with a . (dot) character. 
The domain must start and end with a letter or number.

� The domain name can only contain the following characters:

� Uppercase A-Z and lowercase a-z

� Any digit 0-9

� Hyphen characters (-)

� The domain name must be at least 1 character long.

� The domain name must not exceed 63 characters long.

Customizing the 
Response

You can modify the response screen that is automatically generated by 
the Webcache when a client machine tries to access a Web site that is 
blocked. This allows you to enter additional information to make the 
response screen more user friendly. For example, you could add “Access 
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to this website has been denied. If you do not agree with this site being 
blocked, please contact extension 1234”.

To customize the response using the Web interface:

1 Click Device View on the Toolbar.

2 Select System -> Caching -> Customize Response in the Navigation 
Tree.

3 Enter up to 512 characters of text or HTML code in the Add This Text field 
that you want to add to the response screen that informs the end user 
that access has been denied. The text or HTML that you enter will be 
appended to the standard text that appears, which is “You are not 
authorized to view this page”. You cannot change or delete this standard 
text.

4 If you want to view your changes before saving them to check that your 
text or HTML is correct, click Preview.

Click OK to save the text or HTML code that you have entered.

There is a default option in Microsoft Internet Explorer 4 and later 
versions that will cause a “friendly HTTP error message” to be displayed 
when a Web site is blocked, rather than the response page generated by 
the Webcache. You can turn this setting off by selecting Tools -> Internet 
Options -> Advanced and unchecking Show friendly HTTP error 
messages. The response page generated by the Webcache will never be 
displayed by Internet Explorer if you do not change this setting. The 
following Microsoft knowledgebase article describes the use of friendly 
HTTP-status error messages:

http://support.microsoft.com/support/kb/articles/Q218/1/55.A
SP

What is Web Client 
Blocking?

Web Client Blocking allows you to control which client machines in your 
network can access the Web through the Webcache. If you enable Web 
Client Blocking, you can enter the static IP addresses or IP address ranges 
of client machines that you want to allow access to the Web through the 
Webcache. Web access from all other client machines will be denied by 
the Webcache.

Dynamic Host Configuration Protocol (DHCP) servers can be used with 
Web Client Blocking in two ways:
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� You can configure your network into subnets and assign specific client 
machine MAC addresses to be provided IP addresses within specific 
subnets by DHCP. You can then prevent specific subnet IP address 
ranges from accessing the Web through the Webcache through Web 
Client Blocking.

For example, you configure your user group A to use a subnet defined 
as 10.1.2.0-255, and group B to use another subnet defined as 
10.1.3.0-255. If you want to prevent group B from accessing the Web, 
you would add the subnet 10.1.3.0-255 to the Web Client Blocking 
configuration. Group B would then be unable to access the Web, 
while group A would have access.

� You can configure your DHCP server to return specific IP addresses 
based on the requesting client machine’s MAC address. You can 
configure Web Client Blocking to block either specific client machine 
IP addresses, or ranges of IP addresses, as appropriate.

Configuring Web 
Client Blocking

To configure Web Client Blocking using the Web interface:

1 Log in to the Web interface.

2 Click Device View on the Toolbar.

3 Select System -> Caching -> Client Machine Blocking in the 
Navigation Tree.

4 Check Block Access From All Web Clients to enable Web Client Blocking.

5 In the Except these IP Addresses field, type the IP addresses or IP address 
ranges of the client machines that you want to allow access and click 
Add.

Example

You can enter 216.115.105.2-217.115.105.2 to allow access for that IP 
address range, or enter 216.115.105.2 to allow access for that IP 
address. Separate individual ranges or addresses with a comma.

CAUTION: If the browser on the client machine that you are using to 
configure the Webcache is also using the Webcache as a proxy, and you 
enable Web Client Blocking, you must ensure that you add the client 
machine to the Except these IP Addresses field. If you do not do this, 
access from the client machine to the Webcache will be blocked, 
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preventing you from using the Web interface.You can regain access by 
either:

� Changing the client machine’s browser settings to remove the use of 
the Webcache as a proxy or

� Using a browser on a client machine whose IP address is not blocked 
by Web Client Blocking to access the Web Interface.

CAUTION: If you are using Browser Auto-Configuration Files to configure 
your client machine Web browser settings, and you are using Web Client 
Blocking to control access to the Internet, you should ensure that Go 
Direct if no Webcache Available is not checked in the Browser 
Auto-Configuration screen. If this box is checked, the Web browser will 
bypass the Webcache entirely after reading the Browser 
Auto-Configuration file, and will never be blocked. For more information, 
see “Proxy Auto Configuration (PAC) File Scripts” on page 50.

What is Access 
Logging?

Access Logging allows you to track which client machines have accessed 
which Web sites through the Webcache. By default Access Logging is 
disabled. If you enable Access Logging you must specify a FTP server that 
you want to periodically save the log to. The log is saved to the FTP server 
whenever the log is approaching full, or every 6 hours, whichever comes 
first. You can see a complete history of every web request made through 
the Webcache by combining all the FTPed logs; the saved logs are based 
on the standard Squid access log format and can be analyzed using 
off-the-shelf log analysis tools.

An SNMP trap is automatically generated if the Webcache fails to save 
the access log to the FTP server.

The access logs contain the following fields:

Table 10   Access Log Fields 

Field Description

Time A timestamp expressed as Coordinated Universal Time (UTC) with a 
millisecond resolution.

Elapsed The amount of time in milliseconds that the Webcache took to serve 
the request.

Client The IP address of the requesting client machine.

(continued)
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Configuring Access 
Logging

To configure Access Logging using the Web interface:

1 Log in to the Web interface.

2 Click Device View on the Toolbar.

3 Select System -> Caching -> Access Logging in the Navigation Tree.

4 Check Enable Access Logging. You can view the last 256 lines of the 
Access Log using the View Access Log command; for more information, 
see “Viewing the Access Log” on page 81.

5 Check Enable Web Access Log Save to FTP Server if you want to save the 
access logs onto an FTP server that you specify.

6 In the FTP Server Address field, enter the IP address of the FTP server that 
you want to save the access logs to.

7 In the Directory field, enter the full path within the FTP server that you 
want to save the access logs to.

The directory can only contain alphanumeric and “/”, “.”, “-” or “_” 
characters and can only be up to 32 characters in length.

8 In the Username field, enter the user name for the FTP server that you 
want to save the access logs to.

9 In the Password field, enter the password for the username entered in 
step 8. The password must be between 1 and 32 characters in length.

When a password has been set, ********** is displayed in the Password 
field, regardless of how many characters the password actually has. You 

Action/Code Information on the kind of request and how it was satisfied or how 
it failed i.e. was the request a hit, miss or an error.

Size The amount of data that was delivered to the client machine in 
bytes, including headers.

Method The way in which the Web object was requested i.e. GET, 
CONNECT, TRACE.

URL The URL that the client machine requested.

Ident No value is returned for this field.

Hierarchy/From These fields are not applicable to the Webcache.

Content The content type of the Web object.

Field Description
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can change the password by clicking Change Password and entering the 
new password.

10 If you want to test and upload the Access Log now, click FTP Now. Enter a 
filename for the log and click OK. The filename can only contain 
alphanumeric and . (dot), - (hyphen) or _ (underscore) characters and can 
only be up to 32 characters in length.

Clicking FTP Now will immediately FTP the currently active Access Log to 
the FTP server. This allows you to test your FTP settings or to save the 
Access Log without waiting for the next automatic FTP. Since the 
Webcache may still be writing to the Access Log, using FTP Now may 
result in an incomplete record at the end of the saved Access Log.

If no client machines have accessed a Web site through the Webcache 
before you click FTP Now, then an empty log file will be saved on the FTP 
server.

Viewing the Access 
Log

To view the Access Log using the Web interface:

1 Log in to the Web interface.

2 Click Device View on the Toolbar.

3 Select System -> Caching -> View Access Log in the Navigation Tree.

4 The last 256 lines of the Access Log are displayed.

Click Refresh to update the information that is displayed.

If the Webcache is deployed in Proxy mode, multiple entries for the pages 
in the Web interface itself will be made in the Access Logs. This is 
standard behavior for the Webcache, as it is "seeing" the requests for the 
Web interface pages and logging these requests in the Access Logs. You 
should either leave the Web Interface open for only short periods of time 
to reduce the entries made, or use a log analyzer tool such as Webtrends 
to view and analyze the Access Logs.

Analyzing the 
Access Logs

The access logs that have been saved on the FTP server are based on the 
native Squid format. This is optimized for efficient generation and can be 
analyzed using a wide variety of off-the-shelf log analysis tools.
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3Com recommends that you use Webtrends Log Analyzer to analyze the 
access logs that the Webcache produces:

http://www.webtrends.com
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 SYSTEM EVENTS
This chapter contains information about the system events that can occur 
on the Webcache 1000/3000. It covers the following topics:

� What are System Events?

� Email Notification

� SNMP Traps

What are System 
Events?

System events are events that occur on the Webcache which can be 
reported to you. They range in significance from minor, such as Upgrade 
Started, to major, such as System Failure. You can configure the 
Webcache to automatically inform you about these events using email 
notification and SNMP traps. Such notification allows you to respond 
more quickly to Webcache events and helps save you valuable time and 
effort. It is an important element in the remote management of the 
Webcache.

Email Notification You can configure the Webcache to automatically send emails to 
specified email accounts when certain significant system events occur. 
The emails are generated internally within the Webcache in a fixed 
format that is also used by 3com Network Supervisor. The emails can be 
sent to as many accounts as you like.

Configuring Email
Notification

To configure Email Notification using the Web interface:

1 Log in to the Web interface.

2 Click Device View on the Toolbar.

3 Select System -> Management -> Events -> Email Notification in the 
Navigation Tree. The Email Notification screen is displayed.
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4 Check Enable Email Notifcation of System Events.

5 In the SMTP IP Address field, enter the IP address of the server to which 
the email notifications from the Webcache will be sent.

CAUTION: To use the email notification feature, you must enter the IP 
address of an SMTP server that does not require SMTP authentication in 
the SMTP IP Address field in the Email Notification screen.

6 In the From Addresses for Notifications field, enter the address of the 
email account from which the email notifications will appear to be sent 
from.

CAUTION: If you do not enter a valid email address, the email 
notifications will be rejected by the server that you entered in the SMTP 
Name/IP address field. A valid email address is a fully specified address 
containing a domain name, for example “webcache@3com.com”. The 
partial address “webcache” would be rejected by the server.

3Com recommends that you use the domain name of the Webcache as 
the email address. If you have entered “webcache” as the host name and 
“mycompany.com” as the DNS domain name of the Webcache, then you 
would enter “webcache@mycompany.com” as the email address.

7 In the To Addresses to Receive Notifications field, enter the addresses of 
all the email accounts that will receive the email notifications. Ensure that 
you separate each address with a comma. You can enter up to 255 
characters in this field.

8 You can configure the Webcache to send an email notification when 
certain system events occur by checking the relevant boxes:

� Webcache Software Upgrade Events

This includes the following events:

� A new software upgrade is available.

This email notification will only be sent if you have enabled automatic 
software upgrade detection on the Webcache. You can do this using the 
Upgrade Settings screen.

� A software upgrade has succeeded.

� A software upgrade has failed.

� Webcache System Failure Events

This includes the following events:

� The Webcache has failed its Power On Self Test.
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System Failure is also indicated by a yellow Power/Self Test/System Fault 
LED on the front panel of the Webcache; for more information, see the 
“Introducing the Webcache” chapter on page 17.

� A cache storage device has failed.

9 Click OK.

SNMP Traps You can configure the Webcache to automatically generate Simple 
Network Management Protocol (SNMP) traps when certain significant 
system events occur. An SNMP trap is a message generated by the 
Webcache in response to a particular event. It is sent to a specified 
network management station in your network which receives and filters 
it. You can configure the network management station to log the 
generated traps, filter out the traps that you are not interested in and 
issue event notifications. The structure and content of the SNMP traps are 
defined in the Management Information Bases (MIBs) that the Webcache 
supports.

The Webcache supports the following MIB-2 (standard MIB) and 
Webcache MIB traps:

Table 11   SNMP Traps 

SNMP Trap Description

Cold Start The Webcache is reinitailizing itself such that its system 
configuration may be altered.

Login Failed The admin user has failed to login to the Webcache, or a 
user name other than admin has been entered.

Upgrade Completed 
Successfully

A Software Upgrade has been successfully completed on 
the Webcache.

Upgrade Failed A Software Upgrade has failed on the Webcache.

New Image Detected The Webcache has detected and downloaded a new 
software version that you can choose to upgrade to. The 
trap indicates the current software version on the 
Webcache and the software version that has been 
downloaded.

Image Detection Server 
Unavailable

The FTP site that the Webcache automatically detects and 
downloads software upgrades from is unavailable. You 
can use the Upgrade Settings screen to change the FTP 
site. For more information, see the “Software Upgrade 
and Installation” chapter on page 83.

(continued)
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Configuring SNMP
Traps

To configure SNMP Traps using the Web interface:

1 Log in to the Web interface.

2 Click Device View on the Toolbar.

3 Select System -> Management -> Events -> SNMP Traps in the 
Navigation Tree. The SNMP Trap Destination Setup screen is displayed.

4 Enter the IP address of the network management station in your network 
that will handle the SNMP traps in the IP Address of Management Station 
field.

The community string of the network management station is set to 
“monitor”. You can only change this default setting using the Command 
Line Interface; for more information, see “Setting the Webcache SNMP 
Community String” on page 124.

Caching Disk Failed A cache storage device within the Webcache has failed. 
You have to return the unit to 3Com.

System Error The Webcache can no longer function as a cache due to 
hardware failure.

SNMP Trap Description
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 PERFORMANCE MONITORING
This chapter contains information about monitoring the performance of 
the Webcache 1000/3000. It covers the following topics:

� What is Performance Monitoring?

� Caching Performance Graphs

� System Performance Graphs

� I/O Performance Graphs

What is 
Performance 
Monitoring?

Performance monitoring allows you to assess the caching and system 
performance of the Webcache via a series of easy-to-understand MRTG 
(Multi Router Traffic Grapher) graphs. The Caching Performance graphs 
show the bandwidth savings, hit/miss rate, request rate, response time 
and throughput for the Webcache. You can use them to find out quickly 
and accurately how the Webcache is performing and how much value it 
is providing to your network.

The System Performance and I/O Performance graphs show more detailed 
information which is intended for use by your System Administrator and 
3Com support personnel.

Performance monitoring is always enabled; you cannot turn it off.

Caching 
Performance 
Graphs

The Caching Performance graphs show detailed information about the 
caching performance of the Webcache.

To view the Caching Performance graphs:

1 Log in to the Web interface.

2 Select Performance -> Graphs in the Navigation Tree.
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3 Select Caching Performance Graphs from the available graph types. 
Select one of the three available time periods, Daily, Weekly, or Monthly, 
by clicking the appropriate radio button.

4 Click OK.

The Caching Performance graphs show the following information, which 
is updated every 5 minutes:

� Bandwidth Saving (%)

The average percentage of bandwidth savings obtained through the 
use of the Webcache. This is calculated as the ratio of bytes served by 
the Webcache to total requested bytes.

� Hit and Miss Rate (%)

The percentage of client machine HTTP requests sent to the Webcache 
that have been served from the Webcache (a cache hit) and not served 
from the Webcache (a cache miss). A cache miss requires the content 
to be retrieved from the origin server over the Web.

A high hit rate indicates more efficient operation, as the Webcache is 
saving requests from being sent to the Web, which speeds up 
response time and reduces bandwidth use. A reasonable hit rate is 
40-60%. The hit rate that the Webcache achieves is largely dependant 
upon:

� How frequently the same request is made. The hit rate will be low 
if there is no revisiting of sites. Caching only works well if the same 
request is made frequently. The smaller the range of requests 
made, the more effective the Webache will be and the higher the 
hit rate will be.

� Whether the content provider on the origin web site allows the 
content to be cached or not. Some content providers will prevent 
certain information from being cached.

� Whether the content is frequently changed on the origin web site. 
If so, the copy held on the Webcache must be discarded, and the 
new version retrieved. This is treated as a cache miss.

� Request Rate (sec-1)

The average number per second of client machine HTTP requests sent 
to the Webcache.
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� Hit and Miss Latencies (msec)

The average time per request that the Webcache takes to respond to 
client machine HTTP requests. The response time includes both cache 
hits and cache misses.

A short response time indicates more efficient operation, because 
more content is being served from the high speed Webcache, and less 
from the slow World Wide Web.

� Throughput (Kbits/sec)

The average amount per second of HTTP throughput served by the 
Webcache.

System 
Performance 
Graphs

The System Performance graphs show more detailed information about 
the performance of the Webcache. They are intended for use by your 
System Administrator and 3Com support personnel.

To view the System Performance graphs:

1 Log in to the Web interface.

2 Select Performance -> Graphs in the Navigation Tree.

3 Select System Performance Graphs from the available graph types. Select 
one of the three available time periods, Daily, Weekly, or Monthly, by 
clicking the appropriate radio button.

4 Click OK.

The System Performance graphs show the following information, which is 
updated every 5 minutes:

� CPU Load (%)

The average and maximum percentage of load on the Webcache’s 
central processing unit (CPU).

� Memory Usage (Mbytes)

The average amount of physical memory that is being used in the 
Webcache.

I/O Performance 
Graphs

The I/O (Input/Output) Performance graphs show more detailed 
information about the performance of the Webcache. They are intended 
for use by your System Administrator and 3Com support personnel.
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To view the I/O Performance graphs:

1 Log in to the Web interface.

2 Select Performance -> Graphs in the Navigation Tree.

3 Select I/O Performance Graphs from the available graph types. Select one 
of the three available time periods, Daily, Weekly, or Monthly, by clicking 
the appropriate radio button.

4 Click OK.

The I/O Performance graphs show the following information, which is 
updated every 5 minutes:

� Disk Activity (sec -1)

The average number of disk operations per second to the caching 
disk(s).

� Network Packets (sec -1)

The average number per second of TCP packets sent to and received 
by the Webcache.

� New TCP Connection (sec -1)

The average number per second of TCP connections established by 
the Webcache.

� DNS Lookups (sec -1)

The average number per second of Domain Name System (DNS) server 
requests sent to the Webcache.

� DNS Hit Rate (%)

The average percentage of Domain Name System (DNS) server 
requests served by the Webcache. This is calculated as the ratio of 
host database hits to host database requests.

The Webcache has its own internal cache of DNS entries. The DNS Hit 
Rate shows how effective this cache is being in avoiding DNS lookups to 
the DNS server.
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 SYSTEM DIAGNOSTICS
This chapter contains information about troubleshooting the 
configuration and network connectivity of the Webcache 1000/3000. It 
covers the following topics:

� What are System Diagnostics?

� Pinging Other Devices

� Tracing IP Addresses

� System Log

What are System 
Diagnostics?

You can use the various system diagnostic capabilities of the Webcache to 
help you identify any problems that may occur.

� Ping — Ping other devices on the network.

� Trace Route — Trace the network hops to a device on your network.

� System Log — View information about the Webcache.

Pinging Other 
Devices

The PING feature allows you to send out a PING request to test whether 
devices on an IP network are accessible and functioning correctly. This 
feature is useful to diagnose connectivity problems such as a failed 
network device between the Webcache and the web server being 
accessed.

Performing a Ping To ping a device using the Web interface:

1 Log in to the Web interface.

2 Click Device View on the Toolbar.

3 Select Protocol -> Ping/TraceRoute in the Navigation Tree. The 
Ping/Traceroute screen is displayed.
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4 In the IP Address field, enter the IP address of the device that you want to 
PING. Click Ping.

5 The Webcache sends a single PING request to the specified device and a 
message similar to the following is displayed:

Starting ping, resolution of displayed time is 10
milli-seconds

If the device is accessible and functioning correctly, a message similar to 
the following is displayed:

64 bytes from 192.156.136.22: icmp_seq=0 ttl=248 time=195.2
ms

If the device is not accessible, or is not functioning correctly, a message 
similar to the following is displayed:

No answer from 192.156.136.22

You can interrupt a PING request at any time by clicking Stop.

Tracing IP 
Addresses

The Trace Route feature allows you to display the network hops from the 
Webcache to a device on an IP network. This feature is useful to diagnose 
connectivity problems such as a failed network device between the 
Webcache and the web server being accessed.

Performing a Trace
Route

To perform a trace route to a device using the Web interface:

1 Log in to the Web interface.

2 Click Device View on the Toolbar.

3 Select Protocol -> Ping/TraceRoute in the Navigation Tree. The 
Ping/Traceroute screen is displayed.

4 In the IP Address field, enter the IP address of the device that you want to 
trace. Click TraceRoute.

5 The Webcache sends a trace route request to the specified device and a 
message similar to the following is displayed:

traceroute to 191.128.40.121, 30 hops max, 38 byte packets

If the device is accessible and functioning correctly, a message similar to 
the following is displayed which displays the network hops. Each hop 
may take a few seconds to complete:
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1.routerc1 (140.204.20.20) 1.292ms, 1.343ms, 1.810ms
2.BW-RTR-4.EUR.3Com.COM (161.71.21.45) 26.027ms, 27.156ms,
44.902ms
3.BW-RTR-1.EUR.3Com.COM (140.204.220.15) 24.323ms, 24.854ms,
30.096ms
4.janeway (161.71.123.36) 27.303ms, 33.639ms

If the device is not accessible, or is not functioning correctly, only the hops 
that worked are displayed.

You can interrupt a trace route request at any time by clicking Stop.

System Log The System Log records all of the events that occur on the Webcache and 
displays the information in text format. You can configure how detailed 
the information is, how much of it is displayed and how it is accessed. 
The System Log is primarily intended to be used by your System 
Administrator and 3Com support personnel to troubleshoot the 
Webcache.

Configuring the
System Log

To configure the System Log using the Web interface:

1 Log in to the Web interface.

2 Click Device View on the Toolbar.

3 Select Diagnostics -> Setup System Log in the Navigation Tree. The 
Setup System Log screen is displayed.

4 You can choose to save the contents of the System Log onto a single 
management station in your network that has syslog analysis tools. This is 
of particular benefit if you are working with 3Com support personnel. 
Enter the IP address of the syslog server in the Enter Syslog Server IP 
Address field to enable this feature.

5 If you want to record more detailed system log information, check Enable 
Verbose Logging and select either Low, Medium or High.

By default, the save system log information feature is disabled. You must 
enable this feature if you want to view the entire contents of the System 
Log on a syslog server. You can only view the last 256 lines of the log 
using the View System Log command of the Web interface. However, 
enabling verbose system logging may affect the performance of the 
Webcache because of the extra information that it is recording. You 
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should only enable it if you have been instructed to do so by 3Com 
support personnel.

What is a Syslog
Server?

Syslog is a standard protocol for reporting system events that occur on 
the Webcache and most other modern network devices. A syslog server 
allows you to capture these system events, store them and display them 
in a variety of formats. The purpose of a syslog server is to listen for 
incoming syslog messages (system events) on a UDP port (usually 514) 
and then decode and process the messages for logging and notification 
purposes. Syslog servers are also known as “syslog daemon” or, on Unix, 
“syslogd und Unix”. Unix systems always have a syslog server installed, 
but Microsoft Windows does not include one. 

Obtaining a Syslog
Server

The CD-ROM contains a freeware application called 3CDaemon that 
allows you to configure a Syslog and TFTP server on a Microsoft Windows 
server. You can use the 3CDaemon syslog server to capture syslog events 
from devices and machines on your network. Note that 3CDaemon is 
provided without warranty by 3Com.

WebTrends Firewall Suite has an integral Syslog server which you can also 
use to capture syslog events from devices and machines on your network. 
Download this from:

http://www.webtrends.com
(correct at time of publishing)

Microsoft recommends free syslog servers for Windows:

http://www.microsoft.com/NTServer/nts/exec/vendors/freeshare

/Special.asp

(correct at time of publishing)

You can purchase a syslog server program for Windows. For example you 
can purchase WinSyslog from:

http://www.winsyslog.com/en/
(correct at time of publishing)
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Viewing the System
Log

To view the contents of the System Log using the Web interface:

1 Log in to the Web interface.

2 Click Device View on the Toolbar.

3 Select Diagnostics -> View System Log in the Navigation Tree. The 
System Log screen is displayed. The last 256 lines of the System Log are 
displayed. Click Refresh to update the information that is displayed.

The System Log is primarily intended to be used by your System 
Administrator and 3Com support personnel to troubleshoot the 
Webcache.
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 SOFTWARE UPGRADE AND 
INSTALLATION
This chapter contains information about upgrading and installing the 
management software of the Webcache 1000/3000. It covers the 
following topics:

� What is a Software Upgrade?

� Detecting Software Upgrades

� Performing a Software Upgrade

� What is a Software Installation?

� Performing a Software Installation

� Saving and Restoring Configurations

� Saving a Configuration

� Restoring a Configuration

What is a Software 
Upgrade?

You can upgrade the management software of the Webcache when a 
new version becomes available.

3Com recommends that you always upgrade to the latest software 
version to take advantage of additional functionality, bug fixes and 
features.

You can configure the Webcache to automatically detect and download 
new software versions, and notify you of their availability (via email 
notification; for more information, see “Email Notification” on page 83). 
The next time that you log in to the Webcache, the Upgrade Software 
wizard opens and guides you through the software upgrade process.

Alternatively, you can manually perform a software upgrade, by 
downloading and locating the software upgrade file yourself.



98 CHAPTER 11: SOFTWARE UPGRADE AND INSTALLATION
The configuration of the Webcache is preserved after a software upgrade 
has been performed; you do not have to re-configure the settings.

3Com recommends that you configure the Webcache to automatically 
detect new software versions.

Software Upgrade
SNMP Traps

An SNMP Trap is sent to your network management station when any of 
the following events occur:

� When the software upgrade server is not available and automatic 
software upgrade detection is enabled.

� A new software upgrade is detected.

� A software upgrade is successful.

If the software upgrade is completed successfully, the trap indicates 
that the upgrade has been successful and tells you what software 
version the Webcache is now running.

� A software upgrade fails.

If the software upgrade is completed unsuccessfully, the trap indicates 
that the upgrade has been unsuccessful and tells you why it failed.

For more information about SNMP Traps, see “SNMP Traps” on page 85.

Unsuccessful
Software Upgrades

The Webcache software upgrade process is robust and guards against an 
upgrade failure. Should a software upgrade fail, the Webcache will 
automatically revert to using the software version that was installed 
before the upgrade was started. The upgrade process is resilient to power 
failure, network failure or system failure. Prior to offering an automatic 
software upgrade, the Webcache will download the new software 
version onto temporary storage on the Webcache, ensuring that the 
complete software image file is available before commencing the 
upgrade.

Detecting Software 
Upgrades

To configure the detection of software upgrades using the Web interface:

1 Click Device View on the Toolbar.

2 Select System > Control > Upgrade Settings in the Navigation Tree.
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3 If you want the Webcache to automatically detect and download new 
software versions, and notify you of their availability, check Enable 
Automatic Software Upgrade Detection.

The Webcache notifies you of the availability of new software versions via 
email notification; for further information, see “Email Notification” on 
page 83.

If you want to disable automatic detection, and instead perform software 
upgrades from a file on a local server, ensure that Enable Automatic 
Software Upgrade Detection is unchecked.

4 The default FTP site settings are displayed:

� FTP Server Address: ftp.3com.com

� FTP Server Directory: pub/webcache

� Username: anonymous

� Password: Webcache@hostname.domainname

When a password has been set, ********** is displayed in the Password 
field, regardless of how many characters the password actually is. You 
can change the password by clicking Change Password and entering the 
new password. The password must be between 1 and 32 characters in 
length. The default password is Webcache@hostname.domainname. If 
you set the DNS domain name to be mycompany.com and the DNS host 
name to be mycache, the default FTP password would be 
Webcache@mycache.mycompany.com. If the DNS host name and domain 
are not set, the default password is Webcache.

If necessary, you can change the FTP site that the Webcache automatically 
downloads software upgrades from by entering the new FTP address, 
directory, user name and password in the appropriate fields. You may 
want to change the FTP site in order to download a software upgrade 
from a location other than the default 3Com FTP site.

You can restore the FTP site to the factory defaults by clicking Restore 
Defaults.

Performing a 
Software Upgrade

Performing an Automatically Detected Software Upgrade

This occurs if Enable Automatic Software Upgrade Detection is checked 
in the Upgrade Settings screen and a new software version has been 
detected. The Software Upgrade wizard will automatically start the next 
time that you log in to the Webcache.
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3Com recommends that you save your system configuration settings 
once the Webcache is configured and deployed within your network. 
Saving the configuration settings ensures that you can recover your entire 
system configuration if you ever need to re-install an older software 
version. For more information, see “Saving and Restoring Configurations” 
on page 103.

1 Log in to the Web interface.

2 If a new software version has been detected, the first screen of the 
Upgrade Software wizard is displayed. Click Next.

3 The Software Upgrade Available screen is displayed. Click Next.

4 You have four options to choose from:

� View Upgrade Version Release Notes

Select this to view detailed information about the new software 
version.

� Upgrade Now

Select this to upgrade the Webcache to the new software version 
now.

� Upgrade Later

Select this to upgrade the Webcache to the new software version at a 
later time. You will be reminded about the upgrade when you next log 
in to the Webcache, as the Upgrade Software wizard will 
automatically open.

� Discard Upgrade

Select this if you do not want to upgrade the Webcache to the new 
software version. You will not be reminded about the upgrade to this 
particular version. The Upgrade Software wizard will not offer you the 
chance to upgrade to this version if you discard the software version. 
If you select Discard Upgrade and later wish to install the software 
version, you must disable Automatic Software Upgrade Detection in 
the Upgrade Settings window and perform a manual software 
upgrade.

Select an option and click Next.

5 If you selected View Upgrade Version Release Notes, the release notes are 
displayed in a new instance of the browser window. Click Close to return 
to the Software Upgrade Available screen.

If you selected Upgrade Now, the Finish screen is displayed. Go to step 6.
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If you selected Upgrade Later, the Finish screen is displayed. Click Finish to 
exit the Upgrade Software wizard.

If you selected Discard Upgrade, the Finish screen is displayed. Click Finish 
to exit the Upgrade Software wizard.

6 Carefully read the summary information, which displays the name of the 
software image file, its software version and the date on which it was 
created. Click Finish to start the upgrade.

7 The software upgrade may take several minutes to complete. The 
Software Upgrade Successful screen is displayed when the software 
upgrade has been successful.

8 Click OK to exit the Upgrade Software wizard and reboot the Webcache. 
This will complete the software upgrade. The Device View is displayed in 
the Web interface.

Performing a Manual Software Upgrade

You can manually perform a software upgrade by downloading and 
locating the software upgrade file yourself. You must disable automatic 
software upgrade detection before you can perform a manual upgrade; 
for more information see “Detecting Software Upgrades”on page 98. 
Also, you can only perform a software upgrade if you have downloaded a 
newer software version than the one that is currently installed on the 
Webcache. To do this:

1 Log in to the Web interface.

2 Click Device View on the Toolbar.

3 Select System -> Control -> Upgrade Software in the Navigation Tree. 
The first screen of the Upgrade Software wizard is displayed. Click Next.

4 In the Webcache Software Image field, enter the network path and 
filename of the software image file that you want to upgrade to.

You can click Browse to search for the location of a software image file.

Click Next.

5 The Webcache will verify if the file that you have selected is valid. If it is 
not valid, the software upgrade fails.

6 If the file is valid, the final screen of the wizard is displayed. Carefully read 
the summary information, which displays the name, software version and 
creation date of the current software image file and the new software 
image file that you are upgrading to. Ensure that the software image is 
the one that you want to upgrade to. Click Finish to start the upgrade.
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7 The software upgrade may take several minutes to complete. The 
Software Upgrade Successful screen is displayed when the software 
upgrade has been successful.

8 Click OK to exit the Upgrade Software wizard and reboot the Webcache. 
This will complete the software upgrade. The Device View is displayed in 
the Web interface.

What is a Software 
Installation?

You can install an older version of management software on the 
Webcache than the version that is currently running. This is useful in the 
unlikely event that you are experiencing problems following a software 
upgrade of the Webcache. A software installation should only be 
performed as an emergency recovery procedure.

3Com recommends that you always run the latest software version on 
the Webcache.

CAUTION: Unlike a software upgrade, all of the Webcache’s 
configuration settings are lost after a software installation has been 
completed; the Webcache is reset to its factory defaults. For more 
information, see “Default Settings” on page 22. To restore the settings 
after the installation is complete, you must restore a system configuration 
file that you have previously saved. This configuration file must have been 
saved on the same software version as the software that you have just 
installed. For more information, see “Saving and Restoring 
Configurations” on page 103.

Unsuccessful
Software

Installations

The Webcache software installation process is robust and guards against 
an installation failure. Should a software installation fail, the Webcache 
will automatically revert to using the software version that was installed 
before the installation was started. The installation process is resilient to 
power failure, network failure or system failure.

Performing a 
Software 
Installation

To install an older version of management software using the Web 
interface:

1 Log in to the Web interface.

2 Click Device View on the Toolbar.



Saving and Restoring Configurations 103
3 Select System -> Control -> Install Software in the Navigation Tree. 
The first screen of the Software Installation wizard is displayed. Click 
Next.

4 In the Webcache Software Image field, enter the network path and 
filename of the software image file that you want to install.

You can click Browse to search for the location of a software image file.

Click Next.

5 If the file that you have selected is an invalid Webcache software image, 
the Software Installation Failed screen opens. Click Back to specify the 
location of the software image file again.

If the file that you have selected is a valid Webcache software image, the 
Perform Software Installation screen opens. Go to step 6.

6 Carefully read the summary information, which displays the name of the 
software image file, its software version and the date on which it was 
created. Ensure that the software image is the one that you want to 
install. Click Finish to start the installation.

7 The software installation may take several minutes to complete. The 
Software Installation Successful screen is displayed when the software 
installation has been successful.

8 Click Reboot to exit the Software Installation wizard and reboot the 
Webcache. This will complete the software installation. The Device View 
is displayed in the Web interface.

Saving and 
Restoring 
Configurations

Saving and Restoring configurations is primarily intended to allow you to 
revert to a previous software version in the unlikely event that you are 
experiencing problems following a software upgrade of the Webcache. 
You should always save your system configuration prior to commencing a 
software upgrade. You can save a snapshot of the current configuration 
settings of the Webcache to another client machine or server on your 
network. This is useful if you need to install an older version of software 
on the Webcache, as all configuration settings are lost after a software 
installation. You can save the configuration settings at any time for the 
current Webcache software version. Also, if the Webcache fails and is 
replaced with a new unit, you can use a saved configuration to quickly 
configure the settings of the replacement Webcache.

The Save Configuration operation saves the Webcache’s current system 
configuration as a file in another location on your network. The saved 
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system configuration file includes a record of the Webcache software 
version that was running when the configuration was saved.

The Restore Configuration operation restores the system configuration 
from the file to the Webcache. It checks that the system configuration 
being restored was created on the same Webcache software version as 
the one that the Webcache is running.

Example

You perform a software upgrade and experience problems with the 
Webcache. You now want to return the Webcache to a previous working 
software version. You need to install the previous software version and 
then restore the configuration that you saved prior to commencing the 
upgrade.

To do this, you need to install the software image of the previous 
software version. This is available either on the CD supplied with the 
Webcache or on the 3Com FTP site. The same software image is used for 
installation and for upgrades.

You need to perform a software installation to return the Webcache to a 
previous working software version. All of the Webcache’s configuration 
settings are lost after a software installation has been completed, except 
the IP and DNS configuration. You should now browse to the Webcache’s 
Web interface and restore the system configuration file that you saved 
the last time the Webcache was running this older software version. You 
would perform the Restore Configuration command to go back to a fully 
configured Webcache running the previous software version.

If you had not previously saved a system configuration file for the older 
software version, you would still be able to install a previous software 
image, but you would have to re-enter all of the configuration settings.

CAUTION: You cannot restore a system configuration which was created 
on a different software version to the version that the Webcache is 
currently running.
Example: You save a configuration when the Webcache is running 
software version 1.00. You later perform a software upgrade to version 
1.01 and attempt to restore the 1.00 system configuration to the 
Webcache. The Web interface will not allow you to restore the 
configuration.
Therefore you should save a configuration file for each different software 
version that you run on the Webcache. If you need to go back to an 
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earlier software version via a software installation, you can use a 
matching configuration file to restore the settings.

Saving a 
Configuration

To save the current system configuration of the Webcache using the Web 
interface:

1 Log in to the Web interface.

2 Click Device View on the Toolbar.

3 Select System -> Control -> Save Configuration in the Navigation 
Tree. The Save Configuration screen is displayed. 

4 Click Save.

5 Your Web browser prompts you to enter a filename and to choose a 
location. When you have entered the required information, click OK. The 
save process begins and the Save Configuration screen is closed. The save 
process may take a few seconds to complete.

6 Write down the filename and location of the system configuration file for 
future reference. You should repeat this for every configuration that you 
save.

7 The Save Configuration screen in the Web interface does not close 
automatically when the save process has been completed. Click Cancel to 
close the screen when the configuration has been saved.

You can exit the Save Configuration screen without saving a system 
configuration file by clicking Cancel instead of Save.

Restoring a 
Configuration

To restore a saved system configuration file to the Webcache using the 
Web interface:

1 Log in to the Web interface.

2 Click Device View on the Toolbar.

3 Select System -> Control -> Restore Configuration in the Navigation 
Tree. The Restore Configuration screen is displayed.

4 In the Configuration Filename field, enter the network path and filename 
of the saved system configuration file that you want to restore.

You can click Browse to search for the location of a file.
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CAUTION: You cannot restore a system configuration file which was 
created on a different software version to the version that the Webcache 
is currently running.

5 Click Restore. The restore process begins.

6 The Restore Configuration Successful screen appears. Click OK to reboot 
the Webcache and complete the restoration of the system configuration 
file. The Device View is displayed in the Web interface.

You can exit the Restore Configuration screen without restoring a system 
configuration file by clicking Cancel instead of Restore.
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12
 COMMAND LINE INTERFACE
The Webcache 1000/3000 has a Command Line Interface that allows you 
to manage certain features from a terminal. You may want to use the 
Command Line Interface to setup the Webcache for management 
through the console port or over your network via Telnet.

This chapter describes how to access and use the Command Line 
Interface. It covers the following topics:

� Accessing the Command Line Interface

� Logging In To the Command Line Interface

� Understanding the Command Line Interface

� A Quick Guide to the Commands

� Getting Started

� Displaying and Changing IP-related Information

� Displaying and Changing Security Information

� Displaying and Changing Webcache Information and Functions

Accessing the 
Command Line 
Interface 

You can access the Command Line Interface using:

� A terminal or terminal emulator connected to the console port of the 
Webcache directly, or through a modem.

� A terminal or terminal emulator connected to the Webcache over an 
IP network using Telnet. You can do this in two ways:

� Run a telnet session explicitly to the IP address or Domain Name 
System (DNS) name of the Webcache.

� Select System -> Control -> Telnet in the Web interface. This opens 
a telnet session to the Command Line Interface.

You must use a VT52 or VT100/ANSI compatible terminal emulator.
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Accessing the
Command Line

Interface Through the
Console Port

To manage the Webcache using the Command Line Interface through the 
console port:

1 Connect the terminal or terminal emulator to the console port. 

� If you are connecting directly to the console port, you need a standard 
null-modem cable.

� If you are connecting to the console port using a modem, you need a 
standard modem cable. The console port of the Webcache has a male 
9-pin D-type connector. You can find pin-out diagrams for both cables 
in the “Cable Specifications and Pin-outs” chapter on page 147.

To connect the cable:

a Attach the female connector on the cable to the male connector on 
the console port of the Webcache.

b Tighten the retaining screws on the cable to prevent it from being 
loosened.

c Connect the other end of the cable to your terminal, terminal 
emulator, or modem. Make sure that the terminal, terminal emulator, 
or modem have the same settings as the console port: 

� 8 data bits

� no parity

� 1 stop bit

To configure the settings of the terminal, terminal emulator, or modem, 
see the documentation that accompanies it. You must configure the 
terminal and set the line speed (baud) to match that of the Webcache 
console port. Unless you have changed it, the default line speed is 9600 
baud. You can change the baud rate of the console port via the Web 
interface.

2 Access the Command Line Interface using a valid user name and 
password. Default user names and passwords are described in “Logging 
in as a Default User” on page 58.

3 Configure the basic settings of the Webcache by completing the Getting 
Started wizard. For more information, see “Setting Up Using the 
Command Line Interface” on page 40.
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Accessing the
Command Line

Interface Over the
Network

To manage the Webcache using the Command Line Interface over a 
network using Telnet, open a Telnet session using a terminal emulator by 
specifying the IP address of the Webcache. If you are unsure how to do 
this, check the documentation supplied with the Telnet facility.

Logging In To the 
Command Line 
Interface

To log in to the Command Line Interface, take the following steps:

1 Set up your network for Command Line Interface management; for more 
information, see “Accessing the Command Line Interface” on page 109. 
The login sequence for the Command Line Interface begins as soon as 
the Webcache detects a connection to its console port, or as soon as a 
Telnet session is started.

If the login sequence does not begin immediately, press Return a few 
times until it does begin. If the sequence still does not begin, see “Solving 
Command Line Interface Problems” on page 133.

2 At the Login and Password prompts, enter your user name and password. 
For further information, see “Logging in as a Default User” on page 58.

To prevent unauthorized configuration of the Webcache, 3Com 
recommends that you change the default password as soon as possible. 
To do this using the Command Line Interface, you need to log in as the 
default user and then follow the steps described in “Changing the Admin 
Password” on page 121.

If you have logged on correctly, the Top-level menu of the Command Line 
Interface is displayed as described in “Understanding the Command Line 
Interface” on page 112. If you have not logged on correctly, the message 
Incorrect password. is displayed and the login sequence starts again.

Exiting the Interface You can exit the Command Line Interface at any time; to do this, enter 
logout at the Top-level of the Command Line Interface. If there is a 
period of inactivity lasting longer than 30 minutes, you are logged out of 
the Command Line Interface automatically. After the exit, the first key 
that you press returns you to the login sequence.
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Understanding the 
Command Line 
Interface

Once you log in to the Command Line Interface, the Top-level menu is 
displayed as shown below:

Figure 20   The Top-level Menu

The Command Line Interface is made up of two areas:

� The Menu Area — Contains the current menu of commands. The 
menu can contain commands to configure the Webcache or 
commands to display other menus in the Command Line Interface. 
Each command is accompanied by a brief description of its purpose.

� The Command Area — Contains a Select menu option: prompt 
where you can enter the commands displayed in the menu area.

From the Top-level menu, you can access these sub-menus:

� GettingStarted command

This command allows you to specify basic configuration settings for 
the Webcache.

� Logout command

This command allows you to logout of the Command Line Interface.

� Protocol menu

This menu contains commands that allow you to view and change 
IP-related information and to display diagnostics-related information 
for the Webcache.

� Security menu

This menu contains commands that allow you to view and change 
security-related information for the Webcache and the network.
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� System menu

This menu contains commands that allow you to view and configure 
information about the Webcache.

Entering Commands The command area of the Command Line Interface contains a Select 
menu option prompt that allows you to enter the commands in the menu 
area.

Commands are not case-sensitive.

� To enter a simple command:

At the prompt, enter the name of the command.

� To enter multiple commands:

At the prompt, enter each command in succession. For example, to 
enter the Protocol menu and change the Webcache IP configuration, 
enter:

protocol ip basicConfig

from the Top-level menu.

� To enter commands that require values:

Append the values to the name of the command. For example, to 
display the system menu and change your password, enter:

system password <password>

If you do not specify values for a command that requires them, you 
are prompted to enter the values. At each prompt, the default value is 
displayed in brackets.

� To enter abbreviated commands:

At the prompt, enter enough characters to uniquely identify the 
commands. For example, to enter the security menu and change the 
password for the admin user, enter:

se pa <password>

from the Top-level menu.

� To abort a command

Press [Esc] to return to the Top-level menu.

Displaying Menus There are several ways to display the menus in the Command Line 
Interface menu structure:
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� To display sub-menus:

At the Select menu option prompt, enter the name of the menu or 
menus.

� To display parent menus:

At the Select menu option prompt, enter q.

� To display the Top-level menu:

Press [Esc].

Obtaining Help You can access the Command Line Interface help system at any time by 
entering ? at the Select menu option prompt.

A Quick Guide to 
the Commands

Table 12 describes the commands that are available in the Command Line 
Interface.

Table 12   Command line interface commands

Command What does it do?

gettingStarted Specifies basic setup information for the Webcache.

logout Exits the current user from the Command Line Interface.

protocol ip basicConfig Specifies basic IP management configuration.

protocol ip dnsConfig Specifies Domain Name System (DNS) configuration.

protocol ip initializeConfig Resets IP information to factory default settings.

protocol ip ping Pings other devices on your network.

protocol ip summary Displays IP summary information.

protocol ip traceRoute Traces the network hops to devices on your network.

security password Specifies the password for the current user.

security pwdRecover Enables and disables password recovery.

system control initialize Initializes the Webcache to factory default settings.

system control reboot Reboots the Webcache.

system management community Sets the SNMP community string.

system management contact Specifies a contact name for the Webcache.

system management location Specifies location details for the Webcache.

system management name Specifies a name for the Webcache.

system summary Displays summary information for the Webcache.
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Getting Started The Getting Started command allows you to quickly configure or view 
basic setup information for the Webcache.

To configure basic setup information:

1 At the Top-level menu, enter:

gettingStarted

The following prompt is displayed:

Enter system name:

2 Enter a system name for the Webcache. The name can be up to 80 
characters long.

The following prompt is displayed:

Enter system contact:

3 Enter a system contact for the Webcache. The name can be up to 80 
characters long.

The following prompt is displayed:

Enter system location:

4 Enter a physical location for the Webcache. The location name can be up 
to 80 characters long.

The following prompt is displayed:

Enter IP address [192.168.1.253]:

5 Enter a valid IP address.

The following prompt is displayed:

Enter subnet mask [255.255.255.0]

6 Enter a valid subnet mask.

The following prompt is displayed:

Enter gateway IP address [0.0.0.0]:

7 Enter a valid gateway IP address.

The following prompt is displayed:

Enter host name

8 Enter a valid host name.

The following prompt is displayed:

Enter domain name
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9 Enter a valid domain name.

The following prompt is displayed:

Enter DNS Server IP address [0.0.0.0]:

10 Enter a valid Domain Network System (DNS) Server IP address.

The following prompt and a list of timezones is displayed:

Enter the index of timezone (1-30)[14]:

11 Enter the index number of the timezone that you want the Webcache to 
operate in.

Example

Enter 7 if you want to select (T - 06:00) Central Time (US).

The following prompt is displayed:

Enter time option (NTP,manual) [manual]:

12 Enter either NTP (Network Time Protocol) or manual.

� If you entered NTP, the following prompt is displayed:

Enter NTP server IP address [0.0.0.0]:

Enter a valid NTP server IP address.

� If you entered manual, the following prompt is displayed:

Enter date [dd/mm/yy]:

Enter a valid date.

The following prompt is displayed:

Enter time: [hour:min:sec]

Enter a valid time.

The date and time are set as soon as you press Return.

13 The following prompt is displayed:

Old password:

14 Enter the current password for the admin user.

The following prompt is displayed:

Enter new password:

If you press Return without entering a password, the password is set to 
<no password>.

15 Enter the new password for the admin user.
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The following prompt is displayed:

Retype password:

16 Re-enter the new password. A message is displayed informing you that 
the password has been successfully changed.

The following prompt is displayed:

Please enter mode of operation (proxy, transparent) [proxy]:

17 Enter either proxy or transparent.

For further information, see “Deploying the Webcache in Your Network” 
on page 33.

If you entered proxy, the following prompt is displayed:

Enter caching port number

18 Enter the port number on which the Webcache will listen for traffic.

The Finish prompt is displayed, which summarises the selections that you 
have made.

Exiting the 
Command Line 
Interface

You can exit the Command Line Interface at any time using the logout 
command on the Top-level menu.

To exit the Command Line Interface, at the Top-level menu, enter:

logout

If a period of inactivity lasts longer than 30 minutes, the Webcache will 
automatically log you out.

After the exit, the first key that you press returns you to the login 
sequence.

Displaying and 
Changing IP-related 
Information

You can display and change the IP-related information for the Webcache 
using the commands on the IP menu. These commands allow you to:

� Specify basic IP management configuration

� Configure the Domain Name System settings

� Reset IP information to factory default settings

� Send out a PING request

� Display IP summary information
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� Specify an IP address to be traced

Specifying Basic IP
Configuration

You can use the basicConfig command on the IP menu to configure the 
IP stack of the Webcache. This will allow you to manage the Webcache 
over IP via the CLI or Web interface. This command allows you to 
configure the IP address, subnet mask and the default router IP address.

To configure basic IP management:

1 At the Top-level menu, enter:

protocol ip basicConfig

The following prompt is displayed:

Enter IP address [196.168.100.1]:

2 Enter a valid IP address.

The following prompt is displayed:

Enter Subnet mask [255.255.255.0]

3 Enter a valid subnet mask.

The following prompt is displayed:

Enter Gateway IP address [196.168.100.2]:

4 Enter a valid gateway IP address.

Specifying Domain
Name System
Configuration

You can use the dnsConfig command on the IP menu to configure the 
Domain Name System settings of the Webcache. This command allows 
you to configure the host name, domain name and the Domain Network 
System (DNS) server address.

To configure the Domain Name Settings:

1 At the Top-level menu, enter:

protocol ip dnsConfig

The following prompt is displayed:

Enter host name:

2 Enter a valid host name.

The following prompt is displayed:

Enter domain name

3 Enter a valid domain name.
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The following prompt is displayed:

Enter DNS Server IP address [196.168.100.3]:

4 Enter a valid Domain Name System (DNS) Server IP address.

Resetting IP
Information to

Factory Default
Settings

You can reset all IP information on the Webcache to factory default 
settings using the initializeConfig command on the IP menu. 

To reset IP information to factory defaults:

1 At the Top-level menu, enter:

protocol ip initializeConfig

The following prompt is displayed:

WARNING: This change will lock out all SNMP, Telnet and Web
management access. Do you wish to continue (yes,no)[no]: no

2 Enter yes to reset the IP address for the Webcache.

Pinging Other
Devices

The PING feature allows you to send out a PING request to test whether 
devices on an IP network are accessible and functioning correctly. This 
feature is useful for testing that the Webcache is installed and set up 
correctly, and that your network connections are working.

You can PING other devices on your network using the ping command 
on the IP menu.

To PING a device:

1 At the Top-level menu, enter:

protocol ip ping

The following prompt is displayed:

Enter destination IP address:

2 Enter the IP address of the device that you want to PING.

The Webcache sends a single PING request to the specified device and a 
message similar to the following is displayed:

Starting ping, resolution of displayed time is 10
milli-seconds

If the device is accessible and functioning correctly, a message similar to 
the following is displayed:
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64 bytes from 192.156.136.22: icmp_seq=0 ttl=248 time=195.2
ms

If the device is not accessible, or is not functioning correctly, a message 
similar to the following is displayed:

No answer from 192.156.136.22

Displaying IP
Summary

Information

You can display IP summary information for the Webcache using the 
summary command on the IP menu.

To display the IP information, at the Top-level menu, enter:

protocol ip summary

The IP information for the Webcache is displayed.

An example of the IP information is shown below:

IP address: 196.168.100.1
Subnet mask: 255.255.255.0
Default router: 196.168.100.2
Host Name: webcache
Domain name: mycompany.com
DNS address: 196.168.100.3

Tracing IP Addresses The Trace Route feature allows you to display the network hops from the 
Webcache to a device on an IP network. This feature is useful for testing 
that the Webcache is installed and set up correctly, and that your network 
connections are working.

You can perform a trace route to other devices on your network using the 
traceRoute command on the IP menu.

1 At the Top-level menu, enter:

protocol ip traceRoute

The following prompt is displayed:

Enter destination IP address:

2 Enter the IP address of the device that you want to trace.

The Webcache sends a trace route request to the specified device and a 
message similar to the following is displayed:

traceroute to 191.128.40.121, 30 hops max, 38 byte packets
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If the device is accessible and functioning correctly, a message similar to 
the following is displayed which displays the network hops:

1.routerc1 (140.204.20.20) 1.292ms, 1.343ms, 1.810ms
2.BW-RTR-4.EUR.3Com.COM (161.71.21.45) 26.027ms, 27.156ms,
44.902ms
3.BW-RTR-1.EUR.3Com.COM (140.204.220.15) 24.323ms, 24.854ms,
30.096ms
4.janeway (161.71.123.36) 27.303ms, 33.639ms

If the device is not accessible, or is not functioning correctly, a message 
similar to the following is displayed:

No answer from 191.128.40.121

Displaying and 
Changing Security 
Information

You can display and change the Security-related information for the 
Webcache using the commands on the Security menu. These commands 
allow you to:

� Specify the password for the current user

� Enable and disable password recovery

Changing the Admin
Password

You can change the password for the admin user using the password 
command on the Security menu.

To change the password, you need to login as the admin user and then 
follow the steps below:

1 At the Top-level menu, enter:

security password

The following prompt is displayed, allowing you to enter a new 
password:

Enter the password:

2 Enter the new password for the admin user.

The following prompt is displayed, allowing you to re-enter the new 
password as confirmation:

Re-enter the password:

If you press Return without entering a password, the password is set to 
<no password>.

3 A message is displayed informing you that the password has been 
successfully changed.
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Enabling and
Disabling Password

Recovery

You can enable or disable password recovery for the Webcache using the 
pwdRecover command on the Security menu. For more information 
about password recovery, see the “Security”chapter on page 71.

CAUTION: 3Com recommends that you leave Password Recovery 
enabled. If you disable it and subsequently forget the password for the 
admin user name, you will have to return the Webcache to 3Com.

To enable or disable password recovery:

1 At the Top-level menu, enter:

security pwdRecover

The following example prompt is displayed:

The Password Recovery feature is enabled.
Enter new value (enable,disable) [enable]:

Displaying and 
Changing 
Webcache 
Information and 
Functions

You can display and change information about the Webcache using the 
commands on the System menu. These commands allow you to:

� Initialize the Webcache to factory default settings

� Reboot the Webcache

� Specify a contact name for the Webcache

� Specify location details for the Webcache

� Specify a name for the Webcache

� Specify a community string for the Webcache

� Display summary information for the Webcache

Initializing the
Webcache

You can initialize the Webcache using the initialize command on the 
Control menu.

To initialize the Webcache: 

1 At the Top-level menu, enter: 

system control initialize

The following prompt is displayed:

WARNING: This command initializes the system to factory
defaults (excluding IP details) and causes a reset.
Do you wish to continue (yes,no) [no]:
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2 Enter yes if you wish to proceed, or no if you want to stop the 
initialization.

What Happens During an Initialization?

Initializing the Webcache returns it to its default (factory) settings; for 
more information see “Default Settings” on page 22.

You may want to initialize the Webcache if it has previously been used in 
a different part of your network, and its settings are incorrect for the new 
environment.

CAUTION: Use great care when initializing the Webcache. It removes all 
configuration information, including password and security information.

The Webcache takes approximately 60-90 seconds to initialize. While the 
Webcache is initializing, you cannot communicate with it.

Rebooting the
Webcache

You can reboot the Webcache using the reboot command on the 
Control menu.

To reboot the Webcache:

1 At the Top-level menu, enter:

system control reboot

The following prompt is displayed:

Are you sure you want to reboot the system (yes,no) [no]:

2 Enter yes if you wish to proceed, or no if you want to stop the reboot.

What Happens During a Reboot?

Rebooting the Webcache simulates a power-off/on cycle. The Telnet 
session to the Webcache will be terminated.

The Webcache takes about approximately 60-90 seconds to reboot. 
While the Webcache is being rebooted, you cannot communicate with it.

Specifying a Contact
Name

You can specify contact name details for the Webcache using the 
contact command on the Management menu.
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To specify the contact name details: 

1 At the Top-level menu, enter:

system management contact

The following prompt is displayed:

Enter system contact [<contact name>]:

2 Enter a system contact for the Webcache. The name can be up to 80 
characters long.

Specifying Location
Details

You can specify physical location details for the Webcache using the 
location command on the Management menu.

To specify the location details: 

1 At the Top-level menu, enter:

system management location

The following prompt is displayed:

Enter system location [<location>]:

2 Enter a physical location for the Webcache. The location name can be up 
to 80 characters long.

Specifying a
Webcache Name

You can specify a Webcache name using the name command on the 
Management menu.

To specify the name:

1 At the Top-level menu, enter:

system management name

The following prompt is displayed:

Enter system name [<system name>]:

2 Enter a system name for the Webcache. The name can be up to 80 
characters long.

Setting the Webcache
SNMP Community

String

You can set a new community string for the Webcache using the 
community command on the Management menu. You are setting the 
community string that must be provided by SNMP management 
applications seeking to manage the Webcache.
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To set the community string:

1 At the Top-level menu, enter:

system management community

The following prompt is displayed:

Enter new community for user ‘admin’[private]:

2 Enter a community string for the admin user name.

Displaying Summary
Information

You can display the summary information for the Webcache using the 
summary command on the System menu. This information may be useful 
for your technical support representative if you have a problem.

To display the information:

1 At the Top-level menu, enter: 

system summary

The administration details are displayed as shown in the example below:

The following read-only fields are displayed:

� System Name

Displays the descriptive name, or system name, for the Webcache. For 
information about assigning a new name, see “Specifying a 
Webcache Name”on page 124.

� Location

Displays the physical location of the Webcache. For information about 
assigning a new location, see “Specifying Location Details” on 
page 124.

3Com SuperStack 3

System Name : Development

Location : Wiring Closet, Floor 1

Contact : System Administrator

Time Since Reset : 2 days, 3 hours, 10 minutes

Software Version : 1_00

Hardware Version : 1.0

MAC Address : 08:00:00:00:11:11

Serial Number : 7ZNR001111
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� Contact

Displays the details of a person to contact about the Webcache. For 
information about assigning new contact details, see “Specifying a 
Contact Name” on page 123.

� Time Since Reset

Displays the time that has elapsed since the Webcache was last reset, 
initialized or powered-up.

� Software Version

Displays the version number of the management software currently 
installed on the Webcache.

� Hardware Version

Displays the version number of the Webcache hardware.

� MAC Address

Displays the MAC (Ethernet) address of the Webcache.

� Serial Number

Displays the serial number of the Webcache.
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13
 PROBLEM SOLVING
This chapter contains a list of known problems and suggested solutions. It 
covers the following topics:

� Accessing the Webcache via the Console Line

� Accessing the Webcache via Telnet

� Solving Web Interface Problems

� Solving Command Line Interface Problems

� Solving Webcache Performance Problems

Accessing the 
Webcache via the 
Console Line

The terminal or terminal emulator cannot access the Webcache. 
Check that:

� Your terminal or terminal emulator is correctly configured to operate 
as a generic (TTY) terminal, or a VT100 terminal.

� You have performed the Command Line Interface wake-up procedure 
by pressing [Return] a few times.

� The settings on your terminal or terminal emulator are correct and 
match those set for the Webcache console port:

� 8 data bits

� no parity

� 1 stop bit 

The Webcache only works with line speeds from 1200 to 19,200 
baud. The default line speed of the Webcache is 9600 baud.

If the login sequence still does not display, reset the Webcache. For more 
information, see “Rebooting the Webcache” on page 123. If this does 
not work, initialize the Webcache. For more information, see “Initializing 
the Webcache” on page 122.
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The terminal or terminal emulator can no longer access the 
Webcache over the network. 
Check that the connections and network cabling for the LAN port are in 
place.

If there is still a problem, try accessing the Webcache through a different 
port. If you can now access the Webcache, a problem may have occurred 
with the original port. Contact your supplier for further advice.

Accessing the 
Webcache via 
Telnet

You cannot access the Webcache using Telnet.
Check that:

� The network cables are secure.

� The network cable used to access the Webcache is connected to the 
LAN port.

� The Port Activity LED on the Webcache LAN port is Green or Green 
Flashing.

� The duplex settings are as expected by the rest of your network.

� You can ping the Webcache.

� The terminal or terminal emulator is set to VT52 or VT100 mode.

� Press Return a few times to wake up the CLI.

Solving Web 
Interface Problems

The Web interface is not displayed in the Web browser.
The Web interface can be accessed by any browser that conforms to the 
following W3C standards: HTML 4.0, CSS 1.0, DOM, ECMA 262. To 
display the Web interface correctly, use one of the following Web 
browsers:

� Microsoft Internet Explorer v4.0

� Microsoft Internet Explorer v5.0

� Microsoft Internet Explorer v5.5

� Netscape Communicator v4.5

� Netscape Communicator v4.6

� Netscape Communicator v4.7

Netscape Navigator version 6 is not supported by the Webcache.
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For the browser to operate the Web interface correctly JavaScript™ and 
Cascading Style Sheets must be enabled on your browser. These features 
are enabled on a browser by default. You will only need to enable them if 
you have changed your browser settings.

You cannot access the Web interface.
If the browser on the client machine that you are using to configure the 
Webcache is also using the Webcache as a proxy, and you enable Web 
Client Blocking, you must ensure that you add the client machine to the 
Except these IP Addresses field. If you do not do this, access from the 
client machine to the Webcache will be blocked, preventing you from 
using the Web interface.You can regain access by either:

� Changing the client machine’s browser settings to remove the use of 
the Webcache as a proxy or

� Using a browser on a client machine whose IP address is not blocked 
by Web Client Blocking to access the Web Interface.

You are using Internet Explorer and you cannot access the Web 
interface.
In Netscape, you can enter a shortened URL such as 192.168.1.253:8081 
and Netscape successfully accesses the Webcache. In Internet Explorer, 
however, this URL is not recognized. You must include “http://” at the 
start of the URL i.e. http://192.168.1.253:8081.

You are using Internet Explorer to manage multiple Webcaches 
and the Device Summary table is not updating.
If you are using Internet Explorer to manage more than one Webcache at 
the same time, the settings displayed in the Device Summary table will 
not update when you change between the Webcaches. You must delete 
the browser’s Temporary Internet Pages and then click Refresh to update 
the Web interface with the correct information.

Some of the Web interface is not displayed in the Web browser 
after downloading.
The Web interface responds slowly to commands.
This is probably due either to misbehavior of the Web browser, or large 
amounts of traffic on the network. Reload the Web interface by clicking 
Reload on the browser’s toolbar. If this does not solve the problem, go to 
the end of the URL in the Address field of the browser and press [Return]. 
This causes the page to be reloaded entirely. If this does not solve the 
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problem, click in the part of the Web interface that has not displayed and 
repeat the above.

Some of the text is not displayed in the Web interface windows.
You must ensure that the Display Font Size for your System is set to Small
Fonts (96 dpi). If it is set to Large Fonts, the Web interface will not 
display correctly.

"URL not found" messages are displayed when the Contacts, 
Home Page, Library or Support icons in the Help View are clicked.
Your management workstation cannot access the World Wide Web. 
Contact your network administrator.

You forget the password for the admin user name and can no 
longer perform important management operations.
Use the password recovery method outlined on page 73 to define a new 
password for the admin user name.

The Customize Response page is not displayed when a Web site is 
blocked.
There is a default option in Microsoft Internet Explorer 4 and later 
versions that will cause a “friendly HTTP error message” to be displayed 
when a Web site is blocked, rather than the response page generated by 
the Webcache. You can turn this setting off by selecting Tools > Internet 
Options > Advanced and unchecking Show friendly HTTP error messages.

The Proxy Auto Configuration (PAC) file is ignored by the Web 
browser.
You must set the Web browser to read the PAC file for its settings; for 
more information, see “Proxy Auto Configuration (PAC) File Scripts” on 
page 50. In Netscape, you can enter a shortened PAC address such as 
webcache:8082 and Netscape successfully configures itself using the PAC 
file. In Internet Explorer, however, this address is not recognized and you 
are not warned that the PAC file is being ignored. You must include 
“http://” at the start of the URL i.e. http://webcache:8082.

The System Time does not update in the Web interface
The system time shown in the Device Summary table does not get 
automatically refreshed in the Web interface. Click Refresh in your 
browser to update the time.
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The System Time is inaccurate
Check that:

� The Webcache system time is configured to be set through the 
Network Time Protocol (NTP).

� NTP is enabled on the Webcache. If it is enabled, ping the NTP server 
that you have specified to check that it is operational.

If the NTP server is not functional, or you are not confident it is 
working correctly, try using another NTP server.

� The timezone is set correctly.

Alternatively, the Webcache system time can be set manually. If you have 
configured the system time manually and it is inaccurate, the Webcache 
clock has probably drifted over time. 3Com recommends that you use the 
Network Time Protocol to prevent this. If this is not possible, reset the 
system time manually using the Time Configuration window. Also check 
that the timezone is set correctly.

The Webcache fails to power-up
Check that:

� The Power/Self Test LED on the front panel is Yellow or Off, possibly 
indicating a system error. If so, contact 3Com support personnel.

� If no front panel LEDs are lit, check the power connection to the 
Webcache.

Solving Command 
Line Interface 
Problems

The Command Line Interface responds slowly to commands.
This is probably due to large amounts of traffic on the network. Logout 
and then login again later when the amount of traffic to the Webcache is 
less.

You forget the password for the admin user name and can no 
longer perform important management operations.
Use the password recovery method outlined on page 73 to define a new 
password for the admin user name.
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Solving Webcache 
Performance 
Problems

The performance of the Webcache is poor
Check:

� Whether any of the cache storage devices have failed. Examine the 
front panel LEDs to ensure there are no faults found. If there are, 
contact 3Com support personnel. As long as there is at least one 
working cache storage device, the Webcache will operate as a cache, 
but the failure of a cache storage device will degrade the performance 
of the Webcache. If all cache storage devices have failed, the 
Webcache will pass all requests through to the Web without 
performing any caching.

� The Caching Performance graphs in the Device View -> Performance 
folder. Specifically check the Hit and Miss Rate graph. If the hit rate 
percentage is low, save the system log onto another device in your 
network. Then use a utility like Webtrends to analyze your web traffic 
and see if a higher hit rate is expected.

� Run a network performance test between your client machines and 
your Webcache using the Ping command. Check that the response 
time is reasonable.

� Analyze your network to look for network errors.

� If you are using Proxy Auto Configuration (PAC) files to configure 
browsers, try setting the browser settings manually to avoid the 
overhead of PAC files.

� If you are using the Web Proxy Auto-Discovery (WPAD) protocol to 
configure the browsers on client machines, try setting the browser 
settings manually to avoid the overhead of the WPAD protocol.

� The Webcache Domain Name Server configuration to check that it can 
access the DNS server.

No Web sites can be accessed using the Webcache
Check the Webcache DNS and Default Router settings, and try to ping 
these addresses from the Webcache.

Alternatively, if the Webcache is operating in transparent mode, it will not 
service Web requests from browsers on client machines that are using the 
Webcache as a proxy server. None of those client machines will be able to 
access the Web. You must configure the browsers to use another proxy 
server and bypass the Webcache, or configure the browsers so that they 
are not operating in proxy mode.
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Local domain sites cannot be accessed using the Webcache as a 
proxy
This is caused by an incorrect setting of the DNS domain name on the 
Webcache. Check the DNS configuration of the Webcache.
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A
 SAFETY INFORMATION
You must read the following safety information before carrying out any 
installation or removal of components, or any maintenance procedures 
on the Webcache 1000/3000.

WARNING: Warnings contain directions that you must follow for your 
personal safety. Follow all directions carefully.
You must read the following safety information carefully before you 
install or remove the unit.

AVERTISSEMENT: Les avertissements présentent des consignes que vous 
devez respecter pour garantir votre sécurité personnelle. Vous devez 
respecter attentivement toutes les consignes.
Nous vous demandons de lire attentivement les consignes suivantes de 
sécurité avant d’installer ou de retirer l’appareil.

WARNHINWEIS: Warnhinweise enthalten Anweisungen, die Sie zu Ihrer 
eigenen Sicherheit befolgen müssen. Alle Anweisungen sind sorgfältig zu 
befolgen.
Sie müssen die folgenden Sicherheitsinformationen sorgfältig durchlesen, 
bevor Sie das Gerät installieren oder ausbauen.
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Important Safety 
Information

� Installation and removal of the unit must be carried out by qualified 
personnel only.

� The unit must be earthed (grounded).

� The unit must be connected to an earthed (grounded) outlet to comply 
with European safety standards and EMC standards.

� Power Cord Set
This must be approved for the country where it is used:

� This unit operates under SELV (Safety Extra Low Voltage) conditions 
according to IEC 950. The conditions are only maintained if the 
equipment to which it is connected also operates under SELV conditions.

� The appliance coupler (the connector to the unit and not the wall plug) 
must have a configuration for mating with an EN60320/IEC320 appliance 
inlet.

� The socket outlet must be near to the unit and easily accessible. You can 
only remove power from the unit by disconnecting the power cord from 
the outlet.

UK � The supply plug must comply with BS1363 (3-pin 13 
amp) and be fitted with a 5A fuse which complies with 
BS1362.

� The mains cord must be <HAR> or <BASEC> marked 
and be of type HO3VVF3gO.75 (minimum).

Europe � The supply plug must comply with CEE 7/7 
(“SCHUKO”).

� The supply plug must comply with CE123-16/VII.

USA and 
Canada

� The cord set must be UL-approved and CSA certified.

� The minimum specification for the flexible cord is:
No. 18 AWG
Type SV or SJ
3-conductor

� The cord set must have a rated current capacity of at 
least 10A.

� The attachment plug must be an earth-grounding type 
with a NEMA 5-15P (15A, 125V) or NEMA 6-15P (15A, 
250V) configuration.

Denmark � The supply plug must comply with section 107-2-D1, 
standard DK2-1a or DK2-5a.

Switzerland � The supply plug must comply with SEV/ASE 1011.
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� France and Peru only
This unit cannot be powered from IT† supplies. If your supplies are of IT 
type, this unit must be powered by 230V (2P+T) via an isolation 
transformer ratio 1:1, with the secondary connection point labelled 
Neutral, connected directly to earth (ground).
†Impédance à la terre

� U.K. Only:
If connecting a modem to the console port of the Webcache 
1000/3000, only use a modem which is suitable for connection to the 
telecommunications system.

WARNING: RJ-45 Ports. These are shielded RJ-45 data sockets. They cannot 
be used as standard traditional telephone sockets, or to connect the unit to a 
traditional PBX or public telephone network. Only connect RJ-45 data 
connectors, network telephony systems, or network telephones to these 
sockets.

Either shielded or unshielded data cables with shielded or unshielded 
jacks can be connected to these data sockets.
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Consignes 
importantes de 
sécurité

� L'installation et la dépose de ce groupe doivent être confiés à un 
personnel qualifié.

� Vous devez mettre l’appareil à la terre (à la masse) ce groupe. 

� Vous devez raccorder ce groupe à une sortie mise à la terre (mise à la 
masse) afin de respecter les normes européennes de sécurité.

� Cordon électrique
Il doit être agréé dans le pays d'utilisation :

� L’appareil fonctionne à une tension extrêmement basse de sécurité qui 
est conforme à la norme CEI 950. Ces conditions ne sont maintenues 

Royaume-Uni � La prise secteur doit être conforme aux normes 
BS1363 (tripolaire, 13 amp) et équipée d'un fusible 
5A à conformité BS1362.

� Le cordon secteur doit porter la mention <HAR> ou 
<BASEC> et doit être de type HO3VVF3GO.75 
(minimum).

Europe � La prise secteur doit être conforme aux normes CEE 
7/7 ("SCHUKO")

� La prise secteur doit être conforme aux normes 
CEI23-16/VII.

Etats-Unis et 
Canada

� Le cordon doit avoir reçu l'homologation des UL et 
un certificat de la CSA

� Le cordon souple doit respecter, à titre minimum, les 
spécifications suivantes :

Calibre 18 AWG
Type SV ou 5J
A 3 conducteurs

� Le cordon doit être en mesure d'acheminer un 
courant nominal d'au moins 10 A

� La prise femelle de branchement doit être du type à 
mise à la terre (mise à la masse) et respecter la 
configuration NEMA 5-15P (15 A, 125 V) ou NEMA 
6-15P (15 A, 250 V)

Danemark � La prise mâle d'alimentation doit respecter la section 
107-2 D1 de la norme DK2 1a ou DK2 5a

Suisse � La prise mâle d'alimentation doit respecter la norme 
SEV/ASE 1011
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que si l'équipement auquel il est raccordé fonctionne dans les mêmes 
conditions.

� Le coupleur d'appareil (le connecteur du groupe et non pas la prise 
murale) doit respecter une configuration qui permet un branchement 
sur une entrée d'appareil EN60320/CEI 320.

� France et Pérou uniquement: Ce groupe ne peut pas être alimenté par un 
dispositif à impédance à la terre. Si vos alimentations sont du type 
impédance à la terre, ce groupe doit être alimenté par une tension de 230 
V (2 P+T) par le biais d'un transformateur d'isolement à rapport 1:1, avec 
un point secondaire de connexion portant l'appellation Neutre et avec 
raccordement direct à la terre (masse).

AVERTISSEMENT: Points d’accès RJ-45.  Ceux-ci sont protégés par des 
prises de données.  Ils ne peuvent pas être utilisés comme prises de 
téléphone conventionnelles standard, ni pour la connection de l’unité à 
un réseau téléphonique central privé ou public.  Raccorder seulement  
connecteurs de données RJ-45,  systèmes de réseaux de téléphonie ou 
téléphones de réseaux à ces prises.

Il est possible de raccorder des câbles protégés ou non protégés avec des 
jacks protégés ou non protégés à ces prises de données.
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Wichtige 
Sicherheitsinformat
ionen

� Die Installation und der Ausbau des Geräts darf nur durch Fachpersonal 
erfolgen.

� Das Gerät muß geerdet sein.

� Das Gerät muß an eine geerdete Steckdose angeschlossen werden, die 
europäischen Sicherheitsvorschriften und den Vorschriften zur EMV 
entspricht.

� Netzstecker
Dies muss von dem Land, in dem es benutzt wird geprüft werden.

� Der Betrieb dieses Geräts erfolgt unter den SELV-Bedingungen 
(Sicherheitskleinstspannung) gemäß IEC 950. Diese Bedingungen sind 
nur gegeben, wenn auch die an das Gerät angeschlossenen Geräte 
unter SELV-Bedingungen betrieben werden.

� Der Gerätestecker (der Anschluß an das Gerät, nicht der 
Wandsteckdosenstecker) muß eine passende Konfiguration für einen 
Geräteeingang gemäß EN60320/IEC320 haben.

� Nur für Frankreich: Diese Einheit kann nicht über Anschlüsse des Typs IT† 
betrieben werden. Wenn Sie über IT-Anschlüsse verfügen, muß die Einheit 
über einen geerdeten Trenner mit einem. Übersetzungsverhältnis 1:1 mit 
230 V (2P+T) betrieben werden; dabei muß der zweite Anschlußpunkt die 

Vereinigtes 
Königreich:

� Der Netzstecker muß die Norm BS1363 (13 
Ampere, 3 Stifte) erfüllen und mit einer 
5-A-Sicherung gemäß Norm BS1362 ausgestattet 
sein.

� Das Netzkabel muß vom Typ HO3VVF3GO.75 
(Mindestanforderung) sein und die Aufschrift 
<HAR> oder <BASEC> tragen.

Europa � Der Netzstecker muß die Norm CEE 7/7 erfüllen 
("SCHUKO").

� Der Netzstecker muß die Norm CEI23-16/VII 
erfüllen.

USA und Kanada -

Dänemark � Der Netzstecker muß die Vorschriften laut 
Abshcnitt 107-2-01 der Norm DK2-1a oder 
DK2-5a erfüllen.

Die Schweiz � Der Netzstecker muß die Norm SEV/ASE 1011 
erfüllen.
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Bezeichnung Neutral tragen.
†Impédance à la terre.

WARNHINWEIS: RJ-45-Porte.  Diese Porte sind geschützte 
Datensteckdosen.  Sie dürfen weder wie normale traditionelle 
Telefonsteckdosen noch für die Verbindung der Einheit mit einem 
traditionellem privatem oder öffentlichem Telefonnetzwerk gebraucht 
werden.  Nur RJ-45-Datenanscluße, Telefonnetzsysteme or Netztelefone 
an diese Steckdosen anschließen.

Entweder geschützte oder ungeschützte Buchsen dürfen an diese 
Datensteckdosen angeschlossen werden.
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B
 CABLE SPECIFICATIONS AND 
PIN-OUTS
Cable Specifications The Webcache supports the following cable types:

� Category 3
One of five grades of Twisted Pair (TP) cabling defined by the 
EIA/TIA-586 standard. Category 3 is voice grade cable and can only be 
used in Ethernet networks (10BASE-T) to transmit data at speeds of up 
to 10 Mbps.

� Category 5
One of five grades of Twisted Pair (TP) cabling defined by the 
EIA/TIA-586 standard. Category 5 can be used in Ethernet (10BASE-T) 
and Fast Ethernet networks (100BASE-TX) and can transmit data at 
speeds of up to 100 Mbps. Category 5 cabling is better to use for 
network cabling than Category 3, because it supports both Ethernet 
(10 Mbps) and Fast Ethernet (100 Mbps) speeds.

3Com recommends that you use Category 5 cable — the maximum 
segment length for this type of cable is 100 m (328 ft).
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Pin-outs

Null-Modem Cable 9-pin to RS-232 25-pin

PC-AT Serial Cable 9-pin to 9-pin

Screen

TxD

RxD

Ground

RTS

CTS

DSR

DCD

DTR

Screen

RxD

TxD

Ground

RTS

DTR

CTS

DSR

DCD

Shell

3

2

5

7

8

6

1

4

1

3

2

7

4

20

5

6

8

Webcache 1000/3000
Cable connector: 9-pin female

PC/Terminal
Cable connector: 25-pin male/female

only required if screen

always required

required for handshake

Screen

DTR

TxD

RxD

CTS

Ground

DSR

RTS

DCD

Screen

DCD

RxD

TxD

DTR

Ground

DSR

RTS

CTS

Shell

4

3

2

8

5

6

7

1

Shell

1

2

3

4

5

6

7

8

Webcache 1000/3000
Cable connector: 9-pin female

PC-AT Serial Port
Cable connector: 9-pin female

only required if screen

always required

always required

required for handshake

required for handshake

Required for handshake
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Modem Cable 9-pin to RS-232 25-pin

RJ-45 Pin
Assignments

Pin assignments are identical for 10BASE-T and 100BASE-TX RJ-45 
connectors.

Table 13   Pin Assignments

Screen

TxD

RxD

RTS

CTS

DSR

Ground

DCD

DTR

Screen

TxD

RxD

RTS

CTS

DSR

Ground

DCD

DTR

Shell

3

2

7

8

6

5

1

4

1

2

3

4

5

6

7

8

20

Webcache 1000/3000
Cable connector: 9-pin female

RS-232 Modem Port
Cable connector: 25-pin male

Pin Number Signal Function

Ports configured as MDI

1 Transmit Data + Bidirectional Data A+

2 Transmit Data + Bidirectional Data A-

3 Receive Data + Bidirectional Data B+

4 Not assigned Bidirectional Data C+

5 Not assigned Bidirectional Data C-

6 Receive Data – Bidirectional Data B-

7 Not assigned Bidirectional Data D+

8 Not assigned Bidirectional Data D-

Ports configured as MDIX

1 Receive Data + Bidirectional Data B+

2 Receive Data - Bidirectional Data B-

3 Transmit Data + Bidirectional Data A+

4 Not assigned Bidirectional Data D+

5 Not assigned Bidirectional Data D-

6 Transmit Data – Bidirectional Data A-

7 Not assigned Bidirectional Data C+

8 Not assigned Bidirectional Data C-
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C
 TECHNICAL SPECIFICATIONS
Physical Dimensions Height: 44.45mm (1.75 in.) x Width: 482.6 mm (19.00 in.) x Depth: 610 mm 
(24.02 in.) (not including bulge). Weight: 13 Kg (28.66 lbs)

Environmental Requirements

Operating Temperature 0 ° to 40 °C (32 ° to 104 °F)

Storage Temperature –10 ° to +70 °C (14 ° to 158 °F)

Operating Humidity 10–95% relative humidity, non-condensing

Standards EN60068 to 3Com schedule (Package testing: paras 2.1, 2.2, 2.30, and 2.32. 
Operational testing: paras 2.1, 2.2, 2.30 and 2.13).

Safety

Agency Certifications UL 1950, EN60950, CSA 22.2 No. 950, IEC 60950, NOM-019 SCFI, 
AS/NZS 60950

EMC

Emissions ICES-003 Class A, FCC Part 15 Class A, EN55022 Class A, VCCI Class A, 
AS/NZS 3548 Class A, CISPRR 22 Class A, EN61000-3-2, EN61000-3-3, 
CNS 13438 Class A, Korean EMI Class A

Immunity EN 55024

Heat Dissipation 400 watts maximum (1300 BTU/hour maximum)

Power Supply

AC Line Frequency 50/60 Hz

Input Voltage Options 90–240 VAC

Current Rating 4 A (amps) (maximum)

(continued)
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Standards Supported SNMP:

SNMP protocol (RFC 1517)

MIB-II (RFC 1213)

Interface MIB (RFC 1573)

Remote Monitoring MIB (RFC 
1757)

Terminal Emulation:

Telnet (RFC 854)

Protocols Used for Administration:

UDP (RFC 768)

IP (RFC 791)

ICMP (RFC 792)

TCP (RFC 793)

ARP (RFC 826)

TFTP (RFC 783)



D
 TECHNICAL SUPPORT
3Com provides easy access to technical support information through a 
variety of services. This appendix describes these services.

Information contained in this appendix is correct at time of publication. 
For the most recent information, 3Com recommends that you access the 
3Com Corporation World Wide Web site.

Online Technical 
Services

3Com offers worldwide product support 24 hours a day, 7 days a week, 
through the following online systems:

� World Wide Web site

� 3Com Knowledgebase Web Services

� 3Com FTP site

World Wide Web Site To access the latest networking information on the 3Com Corporation 
World Wide Web site, enter this URL into your Internet browser:

http://www.3com.com/

This service provides access to online support information such as 
technical documentation and software, as well as support options that 
range from technical education to maintenance and professional services.

3Com
Knowledgebase Web

Services

This interactive tool contains technical product information compiled by 
3Com expert technical engineers around the globe. Located on the World 
Wide Web at http://knowledgebase.3com.com, this service gives all 
3Com customers and partners complementary, round-the-clock access to 
technical information on most 3Com products.
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3Com FTP Site Download drivers, patches, software, and MIBs across the Internet from 
the 3Com public FTP site. This service is available 24 hours a day, 7 days a 
week.

To connect to the 3Com FTP site, enter the following information into 
your FTP client:

� Hostname: ftp.3com.com

� Username: anonymous

� Password: <your Internet e-mail address>

You do not need a user name and password with Web browser software 
such as Netscape Navigator and Internet Explorer.

Support from Your 
Network Supplier

If you require additional assistance, contact your network supplier. Many 
suppliers are authorized 3Com service partners who are qualified to 
provide a variety of services, including network planning, installation, 
hardware maintenance, application training, and support services.

When you contact your network supplier for assistance, have the 
following information ready:

� Product model name, part number, and serial number

� A list of system hardware and software, including revision levels

� Diagnostic error messages

� Details about recent configuration changes, if applicable

If you are unable to contact your network supplier, see the following 
section on how to contact 3Com.

Support from 3Com If you are unable to obtain assistance from the 3Com online technical 
resources or from your network supplier, 3Com offers technical telephone 
support services. To find out more about your support options, call the 
3Com technical telephone support phone number at the location nearest 
you.

When you contact 3Com for assistance, have the following information 
ready:

� Product model name, part number, and serial number
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� A list of system hardware and software, including revision levels

� Diagnostic error messages

� Details about recent configuration changes, if applicable

Here is a list of worldwide technical telephone support numbers. These 
numbers are correct at the time of publication. Refer to the 3Com Web 
site for updated information.

Country Telephone Number Country Telephone Number

Asia, Pacific Rim
Australia
Hong Kong
India

Indonesia
Japan
Malaysia
New Zealand
Pakistan
Philippines

1 800 678 515
800 933 486
+61 2 9937 5085 or
000800 6501111
001 800 61 009
03 5783 1270
1800 801 777
0800 446 398
+61 2 9937 5083
1235 61 266 2602

P.R. of China

Singapore
S. Korea

Taiwan, R.O.C.
Thailand

10800 61 00137 or
021 6350 1590 or
00800 0638 3266
800 6161 463
00798 611 2230 or
02 3455 6455
00798 611 2230
0080 611 261
001 800 611 2000

Europe, Middle East and 
Africa
From anywhere in these 
regions, call:

+44 (0)1442 435529 phone
+44 (0)1442 436722 fax

Europe and South Africa
From the following countries, you may use the toll-free numbers:

Austria
Belgium
Denmark
Finland 
France
Germany
Hungary
Ireland
Israel
Italy

0800 297468
0800 71429
800 17309
0800 113153
0800 917959
0800 1821502
06800 12813
1800 553117
1800 9453794
800 8 79489

Luxembourg
Netherlands
Norway
Poland
Portugal
South Africa
Spain
Sweden
Switzerland
U.K.

0800 3625
0800 0227788
800 11376
00800 3111206
0800 831416
0800 995014
900 983125
020 795482
0800 55 3072
0800 966197

Latin America
Brazil
Mexico

0800 13 3266
01 800 849CARE

Puerto Rico
Central and South America

800 666 5065
AT&T +800 998 2112

North America 1 800 NET 3Com
(1 800 638 3266)

Enterprise Customers:
1 800 876-3266
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Returning Products 
for Repair

Before you send a product directly to 3Com for repair, you must first 
obtain an authorization number. Products sent to 3Com without 
authorization numbers will be returned to the sender unopened, at the 
sender’s expense.

To obtain an authorization number, call or fax:

Country Telephone Number Fax Number

Asia, Pacific Rim + 65 543 6500 + 65 543 6348

Europe, Middle East and Africa +44 (0)1442 435529 + 44 (0)1442 436722

Central and South America 525 201 0075

Argentina
Bolivia
Brazil

Caribbean
Chile
Colombia
Ecuador
Mexico
Paraguay
Peru
Uruguay
Venezuela

0810 222 3266
511 241 1691
0800 133266 or
55 11 5643 2700
525 201 0004
562 240 6200
525 201 0004
525 201 0004
525 201 0004
525 201 0004
511 241 1691
525 201 0004
525 201 0004

From the following countries, you may call the toll-free numbers; select option 2 and then option 2:

Austria
Belgium
Denmark
Finland
France
Germany
Hungary
Ireland
Israel
Italy
Netherlands
Norway
Poland
Portugal
South Africa
Spain
Sweden
Switzerland
U.K.

0800 297468
0800 71429
800 17309
0800 113153
0800 917959
0800 1821502
00800 12813
1800553117
1800 9453794
1678 79489
0800 0227788
800 11376
00800 3111206
0800 831416
0800 995014
900 983125
020 795482
0800 55 3072
0800 966197

(continued)



Returning Products for Repair 157
U.S.A. and Canada 1 800 NET 3Com
(1 800 638 3266)

Enterprise Customers:
1 800 876 3266

1 408 326 7120
(not toll-free)

Country Telephone Number Fax Number
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GLOSSARY
3Com Network
Supervisor

The 3Com umbrella management system used to manage all of 3Com’s 
networking solutions.

10BASE-T The IEEE specification for 10 Mbps Ethernet over Category 3, 4 or 5 
twisted pair cable.

100BASE-TX The IEEE specification for 100 Mbps Fast Ethernet over Category 5 
twisted-pair cable.

auto-negotiation A feature on twisted pair ports that allows them to advertise their 
capabilities for speed, duplex and flow control. When connected to a 
port that also supports auto-negotiation, the link can automatically 
configure itself to the optimum setup.

bandwidth The information capacity, measured in bits per second, that a channel 
can transmit. The bandwidth of Ethernet is 10 Mbps and the 
bandwidth of Fast Ethernet is 100 Mbps.

baud The signalling rate of a line, that is, the number of transitions (voltage 
or frequency changes) made per second. Also known as line speed.

cache Stores copies of frequently accessed objects close to users and serves 
them to users when requested.

cache hit An object in the cache that can be served directly to the client 
machine.

cache miss An object that is not in the cache or that is in the cache but no longer 
valid. In both cases, the Webcache must get the object from the origin 
server.

client machine A computer, printer or server that is connected to a network. In this 
User Guide, client machine is used to describe a machine on your 
network which is running a Web browser such as Internet Explorer or 
Netscape Navigator.
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DNS Domain Name System. This system maps a numerical Internet Protocol 
(IP) address to a more meaningful and easy-to-remember name. When 
you need to access another device on your network, you enter the 
name of the device, instead of its IP address.

Ethernet A LAN specification developed jointly by Xerox, Intel and Digital 
Equipment Corporation. Ethernet networks use CSMA/CD to transmit 
packets at a rate of 10 Mbps over a variety of cables.

Ethernet address See MAC address.

Fast Ethernet An Ethernet system that is designed to operate at 100Mbps.

FTP File Transfer Protocol. A protocol based on TCP/IP for reliable file 
transfer.

full duplex A system that allows packets to be transmitted and received at the 
same time and, in effect, doubles the potential throughput of a link.

gateway See router.

half duplex A system that allows packets to transmitted and received, but not at 
the same time. Contrast with full duplex.

HTTP Hypertext Transfer Protocol. This is a set of rules for exchanging files 
(text, graphic images, sound, video, and other multimedia files) on the 
World Wide Web.

IETF Internet Engineering Task Force. An organization responsible for 
providing engineering solutions for TCP/IP networks. In the network 
management area, this group is responsible for the development of the 
SNMP protocol.

Intranet An Intranet is an organisation wide network using Internet protocols 
such as web services, TCP/IP, HTTP and HTML. An Intranet is normally 
used for internal communication and information, and is not accessible 
to computers on the wider Internet.

IP Internet Protocol. IP is a layer 3 network protocol that is the standard 
for sending data through a network. IP is part of the TCP/IP set of 
protocols that describe the routing of packets to addressed devices.

IP address Internet Protocol address. A unique identifier for a device attached to a 
network using TCP/IP. The address is written as four octets separated 
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with periods (full-stops), and is made up of a network section, an 
optional subnet section and a host section.

LAN Local Area Network. A network of client machines (such as PCs, 
printers, servers) and network devices (hubs and switches) that cover a 
relatively small geographic area (usually not larger than a floor or 
building). LANs are characterized by high transmission speeds over 
short distances (up to 1000 m).

LAN port An auto-negotiating 10BASE-T/100BASE-TX RJ-45 port which is used to 
connect the Webcache to the network in either Proxy or Transparent 
deployment environments.

latency The delay between a web request being issued from the Web browser 
on a client machine and the information arriving back at the browser.

line speed See baud.

MRTG Multi Router Traffic Grapher. A graphing tool provided with the 
Webcache that enables you to monitor the Webcache’s performance.

NTP Network Time Protocol. This protocol is used to synchronize the time of 
client machines and servers with other well-known, highly accurate 
servers or reference time sources (such as a radio, satellite receiver or 
modem). It maintains a consistent Coordinated Universal Time (UTC) 
within your network which is far more accurate than the internal 
system clocks of client machines.

origin server The web server that contains the original copy of the requested 
information.

PAC Proxy Auto Configuration. PAC files allow you to create configuration 
rules that determine how Web browsers operate when the Webcache is 
being deployed in a Proxy cache.

PING Packet Internet or Inter-Network Gropher. This feature allows you to 
send out a PING request to test whether devices on an IP network are 
accessible and functioning correctly.

protocol A set of rules for communication between devices on a network. The 
rules dictate format, timing, sequencing and error control.
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proxy cache The Webcache is connected to a Layer 2 switch in your LAN. The Web 
browser on each client machine in your network must be configured to 
explicitly direct its Web requests to the Webcache.

router A router is a device on your network which is used to forward IP 
packets to a remote destination. An alternative name for a router is a 
gateway.

server A computer in a network that holds the master version of a web 
page/object. A web request that is not served by the Webcache must 
go to the server across the World Wide Web. This is termed a cache 
miss. A web request served by the Webcache is termed a cache hit.

SNMP Simple Network Management Protocol. The current IETF standard 
protocol for managing devices on an TCP/IP network.

subnet An IP network can be divided into sub-networks, also known as 
subnets. If you have a small network (less than 254 devices), you may 
decide not to have multiple subnets.

subnet mask A subnet mask is used to divide the device part of the IP address into two 
further parts. The first part identifies the subnet number. The second part 
identifies the device on that subnet.

TCP/IP Transmission Control Protocol/Internet Protocol. This is the name for 
two of the most well-known protocols developed for the 
interconnection of networks. Originally a UNIX standard, TCP/IP is now 
supported on almost all platforms, and is the protocol of the Internet.

TCP relates to the content of the data travelling through a network — 
ensuring that the information sent arrives in one piece when it reaches 
its destination. IP relates to the address of the client machine to which 
data is being sent, as well as the address of the destination network.

Telnet A TCP/IP application protocol that provides a virtual terminal service, 
letting a user log into another computer system and access a device as 
if the user were connected directly to the device.

trace route This feature allows you to display the network hops from the 
Webcache to a device on an IP network. 

transparent cache The Webcache is connected to a Layer 4 device in your LAN which is 
capable of Redirection. The Layer 4 switch (also known as a Layer 4 
redirector or Web enabled switch) automatically redirects all Web 
requests to the Webcache.
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VLAN Virtual LAN. A group of location- and topology-independent devices 
that communicate as if they are on the same physical LAN.

WAN Wide Area Network. A communications network that covers a wide 
area. A WAN can cover a large geographic area, and may contain 
several LANs within it.

URL Uniform Resource Locator. The address that defines the route to a file 
on the web or other Internet facility.

UTC Coordinated Universal Time. This is the standard time common to every 
place in the world. Formerly and still widely called Greenwich Mean 
Time (GMT) and also World Time, UTC nominally reflects the mean 
solar time along the Earth's prime meridian.

WAN port On the Webcache, the WAN port is an auto-negotiating 
10BASE-T/100BASE-TX RJ-45 port which is used to connect the 
Webcache to the network in an inline deployment environment.

WPAD Web Proxy Auto-Discovery. This protocol enables the Web browser on 
client machines to automatically find and load proxy configuration 
information from a server without user intervention.
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INDEX

Numbers
10BASE-T/100BASE-TX port 21
3Com Knowledgebase Web Services 153
3Com Network Supervisor 18, 83
3Com URL 153

A
access levels of default users 58
Access Logging 79

analyzing the logs 81
configuring 80
squid format 79
viewing 81

accessing the Web interface 39, 58
addresses

IP 45
admin user name 71

B
banner 60
basicConfig command 118
blocking access

client machines 77
Web sites 75

C
cable

modem 41
null-modem 41
pin-outs 147, 148
specifications 147

cache
proxy 33

manually configuring Web browsers 49
Proxy Auto Configuration (PAC) 50
Web Proxy Auto-Discovery (WPAD) 53

transparent 33, 34
caching performance graph 87

bandwidth saving 88
hit and miss latencies 89
hit and miss rate 88
request rate 88
throughput 89

CD-ROM 26
Command Line Interface 109

accessing 109
basicConfig command 118
community command 124
contact command 123
displaying menus 113
dnsConfig command 118
entering commands 113
exiting 111
getting started command 115
help 114
initialize command 122
initializeConfig command 119
IP 117
location command 124
logging in 111
logout 111
logout command 117
management

setting up over the network 111
setting up through the console port 110, 

111
name command 124
operating 111
password command 121
ping command 119
pwdRecover command 122
quick guide 114
reboot command 123
Security 121
solving problems 133
summary (System) command 125
summary command 120
System 122
traceroute command 120
understanding 112

community command 124
community string 124
configurations

restoring 103, 105
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saving 103, 105
connecting to the live network 44
console port 20, 41

hotspot 62
contact command 123
controlling Web access 75
conventions

notice icons, About This Guide 12
text, About This Guide 12

Coordinated Universal Time 68
cross-over cable 38
customizing the response 76

D
default

IP address 38, 40
settings 22
users 58

deploying the Webcache 49, 57
proxy cache 33
transparent cache 34

Device Mimic 62
Device Summary 63
Device View 61
diagnostics 91
dnsConfig command 118
documentation

release notes 26
user guide 26

Domain Name System (DNS) 47
syntax 47

E
Email Notification 83

configuring 83
events 93
events, system 83

email notification 83
configuring 83

SNMP Traps 85
configuring 86

F
factory defaults 22
forgetting your password 72
front panel 19
front panel LEDs 19

activity 20
cache storage status 19
link status 19
power/self test 20

G
getting started command 115

H
Help View 63
hotspots

console port 62
LAN port 62
unit 62

I
I/O performance graph 89

disk activity 90
DNS hit rate 90
DNS lookups 90
network packets 90
new TCP connection 90

information area 65
initialize command 23, 122
initializeConfig command 119
installing software 102

performing 102
unsuccessful 102

installing the Webcache 25
Internet

addresses 45
InterNIC 45
introducing the Webcache 17
IP address 45

default 38, 40
obtaining 45

L
LAN port 21, 44

Hotspot 62
LEDs 21

LEDs
colour 32
front panel 19

activity 20
cache storage status 19
link status 19
power/self test 20

LAN port 21
operation 32
problems 32
rear panel 21



INDEX 167
link speed 22
port activity 22

WAN port 21
location command 124
log, system 93

configuring 93
viewing 95

logging access 79
analyzing the logs 81
configuring 80
viewing 81

logging in
password 71
user name 71

logging in as a default user 58
logout command 117

M
management

Command Line Interface 109
Management Information Bases 85
management software

installing 102
upgrading 97

management software installation 102
performing 102
unsuccessful 102

management software upgrades
configuring 98
performing 99
SNMP Traps 98
unsuccessful 98

managing the Webcache 57
MIBs 85, 154
mimic 62
modem cable 41

pin-outs 149
monitoring performance 87
monitoring Web access 75

N
name command 124
navigation tree 64
network

addresses 45
hops 92

Network Supervisor 18
network supplier support 154
Network Time Protocol 67, 68

choosing a server 68
configuring 69
public servers 68
network, deploying the Webcache 49, 57
NTP 67
null-modem cable 41

pin-outs 148

O
obtaining

registered IP address 45
online technical services 153

P
package contents 26
password command 121
password recovery 72

disabling 72
enabling 72
performing 73

passwords 71
of default users 58
setting 71

PC-AT serial cable
pin-outs 148

performance graphs
caching 87

bandwidth saving 88
hit and miss latencies 89
hit and miss rate 88
request rate 88
throughput 89

I/O 89
disk activity 90
DNS hit rate 90
DNS lookups 90
network packets 90
new TCP connection 90

system 89
CPU load 89
memory usage 89

performance monitoring 87
ping 91
ping command 119
pin-outs 147, 148

modem cable 149
null-modem cable 148
PC-AT serial cable 148
RJ-45 assignments 149

port
console 20
LAN 21, 44
RJ-45 20



168 INDEX
WAN 21
positioning the Webcache 26
power cord 26
power socket 20
power-up 31
problem solving 129

command line interface 133
Web interface 130

Proxy Auto Configuration (PAC) 50
proxy cache 33

manually configuring Web browsers 49
Proxy Auto Configuration (PAC) 50
Web Proxy Auto-Discovery (WPAD) 53

proxy mode 21
pwdRecover command 122

R
rack-mounting 27
rack-mounting kit 26
rear panel 20

console port 20
LAN port 21
LEDs 21

link speed 22
port activity 22

power socket 20
WAN port 21

reboot command 123
registered IP address, obtaining 45
release notes 26
response, customizing 76
Restore Configuration 103, 105
returning products for repair 156
RJ-45 assignments 149
RJ-45 ports 20

S
Safety Information 139

English 140
French 142
German 144

Save Configuration 103, 105
security 71
setting a password 71
setting up the Webcache 25, 36

using the Command Line Interface 40
using the Web interface 38

Simple Network Management Protocol 85
siting the Webcache 26
SNMP

community string 124
SNMP Traps 85, 86
software upgrades 98

software 97
installation 97
upgrade 97

Software Installation 102
performing 102
unsuccessful 102

Software Upgrades 97
configuring 98
performing 99
SNMP Traps 98
unsuccessful 98

solving problems 129
specifications, technical 151
Squid 79
stratums 68
subnet mask 46
subnets 46
sub-networks. See subnets
summary (System) command 125
summary command 120
Summary View 61
syslog server 94
system diagnostics 91
System Events 83

email notification 83
configuring 83

SNMP Traps 85
configuring 86

System Log 93
configuring 93
viewing 95

system performance graph 89
CPU load 89
memory usage 89

system time 67
configuring 67
manual 69
Network Time Protocol 69

T
technical specifications 151
technical support

3Com Knowledgebase Web Services 153
3Com URL 153
network suppliers 154
product repair 156

test network 38, 40
third-party tools 54
time configuration 67
toolbar 61
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trace route 92
traceroute command 120
tracking access 79

analyzing the logs 81
configuring 80
viewing 81

transparent cache 33, 34
transparent mode 21
troubleshooting 91

U
Unit hotspot 62
upgrading software 97

configuring 98
performing 99
SNMP Traps 98
unsuccessful 98

URL 153
user guide 26
user name, admin 71

V
view

Device 61
Help 63
Summary 61

W
WAN port 21

LEDs 21
Warranty Card 26
Web access

controlling 75
monitoring 75

Web browsers
configuring with third-party tools 54
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3COM END USER SOFTWARE LICENSE AGREEMENT

IMPORTANT: Read Before Using This Product

YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE USING THIS 
PRODUCT. IT CONTAINS SOFTWARE, THE USE OF WHICH IS LICENSED BY 3COM CORPORATION 
(“3COM”) TO ITS CUSTOMERS FOR THEIR USE ONLY AS SET FORTH BELOW. IF YOU DO NOT AGREE 
TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT USE THE SOFTWARE. USING ANY 
PART OF THE SOFTWARE INDICATES THAT YOU ACCEPT THESE TERMS.

LICENSE: 3Com grants you a nonexclusive license to use the accompanying software program(s) (the 
“Software”) subject to the terms and restrictions set forth in this License Agreement. You are not permitted 
to lease, rent, distribute or sublicense the Software or to use the Software in a time-sharing arrangement or 
in any other unauthorized manner. Further, no license is granted to you in the human readable code of the 
Software (source code). Except as provided below, this License Agreement does not grant you any rights to 
patents, copyrights, trade secrets, trademarks, or any other rights in respect to the Software.

The Software is licensed to be used on any workstation or any network server owned by or leased to you, 
provided that the Software is used only in connection with a 3Com adapter. You may reproduce and provide 
one (1) copy of the Software and supporting documentation for each such workstation or network server on 
which the Software is used as permitted hereunder. Otherwise, the Software and supporting documentation 
may be copied only as essential for backup or archive purposes in support of your use of the Software as 
permitted hereunder. You must reproduce and include all copyright notices and any other proprietary rights 
notices appearing on the Software and the supporting documentation on any copies that you make.

NO ASSIGNMENT; NO REVERSE ENGINEERING: You may not transfer or assign the Software and/or this 
License Agreement to another party without the prior written consent of 3Com. If such consent is given and 
you transfer or assign the Software and/or this License Agreement, then you must at the same time either 
transfer any copies of the Software as well as the supporting documentation to the same party or destroy any 
such materials not transferred. Except as set forth above, you may not transfer or assign the Software or your 
rights under this License Agreement. 

Modification, reverse engineering, reverse compiling, or disassembly of the Software is expressly prohibited. 
However, if you are a European Community (“EC”) resident, information necessary to achieve interoperability 
of the Software with other programs within the meaning of the EC Directive on the Legal Protection of 
Computer Programs is available to you from 3Com upon written request.

EXPORT RESTRICTIONS: You agree that you will not export or re-export the Software or accompanying 
documentation (or any copies thereof) or any products utilizing the Software or such documentation in 
violation of any applicable laws or regulations of the United States and the country in which you obtained 
them.

TRADE SECRETS; TITLE: You acknowledge and agree that the structure, sequence and organization of the 
Software are the valuable trade secrets of 3Com and its suppliers. You agree to hold such trade secrets in 
confidence. You further acknowledge and agree that ownership of, and title to, the Software and all 
subsequent copies thereof regardless of the form or media are held by 3Com and its suppliers.

UNITED STATES GOVERNMENT LEGEND: All technical data and computer software are commercial in 
nature and developed solely at private expense. The Software is delivered as “Commercial Computer 
Software” as defined in DFARS 252.227-7014 (June 1995) or as a “commercial item” as defined in 
FAR 2.101(a) and as such is provided with only such rights as are provided in this License Agreement, which is 
3Com’s standard commercial license for the Software. Technical data is provided with limited rights only as 
provided in DFAR 252.227-7015 (Nov. 1995) or FAR 52.227-14 (June 1987), whichever is applicable. You 
agree not to remove or deface any portion of any legend provided on any licensed program or 
documentation delivered to you under this License Agreement.

TERM AND TERMINATION: This license will expire fifty (50) years from the date that you first use the 
Software, if it is not earlier terminated. You may terminate it at any time by destroying the Software and 
documentation together with all copies and merged portions in any form. It will also terminate immediately if 
you fail to comply with any term or condition of this License Agreement. Upon such termination you agree to 
destroy the Software and documentation, together with all copies and merged portions in any form.

GOVERNING LAW: This License Agreement shall be governed by the laws of the State of California as such 
laws are applied to agreements entered into and to be performed entirely within California between 
California residents and by the laws of the United States. You agree that the United Nations Convention on 
Contracts for the International Sale of Goods (1980) is hereby excluded in its entirety from application to this 
License Agreement.

LIMITED WARRANTY; LIMITATION OF LIABILITY: All warranties and limitations of liability applicable to the 
Software are as stated on the Limited Warranty Card or in the product manual, whether in paper or 
electronic form, accompanying the Software. Such warranties and limitations of liability are incorporated 
herein in their entirety by this reference. 

SEVERABILITY: In the event any provision of this License Agreement is found to be invalid, illegal or 
unenforceable, the validity, legality and enforceability of any of the remaining provisions shall not in any way 



be affected or impaired and a valid, legal and enforceable provision of similar intent and economic impact 
shall be substituted therefor.

ENTIRE AGREEMENT: This License Agreement sets forth the entire understanding and agreement between 
you and 3Com, supersedes all prior agreements, whether written or oral, with respect to the Software, and 
may be amended only in a writing signed by both parties. 

3Com is a registered trademark of 3Com Corporation.

3Com Corporation, 5400 Bayfront Plaza, P.O. Box 58145, Santa Clara, CA 95052-8145. (408) 764-5000

GNU GENERAL PUBLIC LICENSE VERSION 2, JUNE 1991

The 3Com Webcache uses the Linux operating system and MRTG graphing package, both are 
covered by the GNU General Public Licence. These items of software are used unmodified.

The source code for the version of Linux used is available on the 3Com FTP site at ftp.3com.com

Copyright (C) 1989, 1991 Free Software Foundation, Inc., 59 Temple Place, Suite 330, Boston MA 
02111-1307 USA. Everyone is permitted to copy and distribute verbatim copies of this license document, but 
changing it is not allowed.

Preamble

The licenses for most software are designed to take away your freedom to share and change it. By contrast, 
the GNU General Public License is intended to guarantee your freedom to share and change free software--to 
make sure the software is free for all its users. This General Public License applies to most of the Free 
Software Foundation's software and to any other program whose authors commit to using it. (Some other 
Free Software Foundation software is covered by the GNU Library General Public License instead.) You can 
apply it to your programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are 
designed to make sure that you have the freedom to distribute copies of free software (and charge for this 
service if you wish), that you receive source code or can get it if you want it, that you can change the 
software or use pieces of it in new free programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you 
to surrender the rights. These restrictions translate to certain responsibilities for you if you distribute copies of 
the software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the 
recipients all the rights that you have. You must make sure that they, too, receive or can get the source code.  
And you must show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives 
you legal permission to copy, distribute and/or modify the software.

Also, for each author's protection and ours, we want to make certain that everyone understands that there is 
no warranty for this free software. If the software is modified by someone else and passed on, we want its 
recipients to know that what they have is not the original, so that any problems introduced by others will not 
reflect on the original authors' reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that 
redistributors of a free program will individually obtain patent licenses, in effect making the program 
proprietary. To prevent this, we have made it clear that any patent must be licensed for everyone's free use or 
not licensed at all.

The precise terms and conditions for copying, distribution and modification follow.

GNU GENERAL PUBLIC LICENSE TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND 
MODIFICATION

0. This License applies to any program or other work which contains a notice placed by the copyright holder 
saying it may be distributed under the terms of this General Public License.  The "Program", below, refers to 
any such program or work, and a "work based on the Program" means either the Program or any derivative 
work under copyright law: that is to say, a work containing the Program or a portion of it, either verbatim or 
with modifications and/or translated into another language.  (Hereinafter, translation is included without 
limitation in the term "modification".)  Each licensee is addressed as "you".

Activities other than copying, distribution and modification are not covered by this License; they are outside 
its scope.  The act of running the Program is not restricted, and the output from the Program is covered only 
if its contents constitute a work based on the Program (independent of having been made by running the 
Program).Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program's source code as you receive it, in any 



medium, provided that you conspicuously and appropriately publish on each copy an appropriate copyright 
notice and disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of 
any warranty; and give any other recipients of the Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty 
protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the 
Program, and copy and distribute such modifications or work under the terms of Section 1 above, provided 
that you also meet all of these conditions:

a) You must cause the modified files to carry prominent notices stating that you changed the files and the 
date of any change.

b) You must cause any work that you distribute or publish, that in whole or in part contains or is derived from 
the Program or any part thereof, to be licensed as a whole at no charge to all third parties under the terms of 
this License.

c) If the modified program normally reads commands interactively when run, you must cause it, when started 
running for such interactive use in the most ordinary way, to print or display an announcement including an 
appropriate copyright notice and a notice that there is no warranty (or else, saying that you provide a 
warranty) and that users may redistribute the program under these conditions, and telling the user how to 
view a copy of this License.  (Exception: if the Program itself is interactive but does not normally print such an 
announcement, your work based on the Program is not required to print an announcement.)

These requirements apply to the modified work as a whole.  If identifiable sections of that work are not 
derived from the Program, and can be reasonably considered independent and separate works in themselves, 
then this License, and its terms, do not apply to those sections when you distribute them as separate works.  
But when you distribute the same sections as part of a whole which is a work based on the Program, the 
distribution of the whole must be on the terms of this License, whose permissions for other licensees extend 
to the entire whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; 
rather, the intent is to exercise the right to control the distribution of derivative or collective works based on 
the Program.

In addition, mere aggregation of another work not based on the Program with the Program (or with a work 
based on the Program) on a volume of a storage or distribution medium does not bring the other work under 
the scope of this License.

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or 
executable form under the terms of Sections 1 and 2 above provided that you also do one of the following:

a) Accompany it with the complete corresponding machine-readable source code, which must be distributed 
under the terms of Sections 1 and 2 above on a medium customarily used for software interchange; or,

b) Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no 
more than your cost of physically performing source distribution, a complete machine-readable copy of the 
corresponding source code, to be distributed under the terms of Sections 1 and 2 above on a medium 
customarily used for software interchange; or,

c) Accompany it with the information you received as to the offer to distribute corresponding source code.  
(This alternative is allowed only for noncommercial distribution and only if you received the program in object 
code or executable form with such an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for making modifications to it.  For an 
executable work, complete source code means all the source code for all modules it contains, plus any 
associated interface definition files, plus the scripts used to control compilation and installation of the 
executable.  However, as a special exception, the source code distributed need not include anything that is 
normally distributed (in either source or binary form) with the major components (compiler, kernel, and so 
on) of the operating system on which the executable runs, unless that component itself accompanies the 
executable.

If distribution of executable or object code is made by offering access to copy from a designated place, then 
offering equivalent access to copy the source code from the same place counts as distribution of the source 
code, even though third parties are not compelled to copy the source along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this 
License.  Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will 
automatically terminate your rights under this License. However, parties who have received copies, or rights, 
from you under this License will not have their licenses terminated so long as such parties remain in full 
compliance.

5. You are not required to accept this License, since you have not signed it.  However, nothing else grants you 
permission to modify or distribute the Program or its derivative works.  These actions are prohibited by law if 
you do not accept this License.  Therefore, by modifying or distributing the Program (or any work based on 
the Program), you indicate your acceptance of this License to do so, and all its terms and conditions for 
copying, distributing or modifying the Program or works based on it.



6. Each time you redistribute the Program (or any work based on the Program), the recipient automatically 
receives a license from the original licensor to copy, distribute or modify the Program subject to these terms 
and conditions.  You may not impose any further restrictions on the recipients' exercise of the rights granted 
herein.You are not responsible for enforcing compliance by third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not 
limited to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise) 
that contradict the conditions of this License, they do not excuse you from the conditions of this License.  If 
you cannot distribute so as to satisfy simultaneously your obligations under this License and any other 
pertinent obligations, then as a consequence you may not distribute the Program at all.  For example, if a 
patent license would not permit royalty-free redistribution of the Program by all those who receive copies 
directly or indirectly through you, then the only way you could satisfy both it and this License would be to 
refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance 
of the section is intended to apply and the section as a whole is intended to apply in other circumstances. It is 
not the purpose of this section to induce you to infringe any patents or other property right claims or to 
contest validity of any such claims; this section has the sole purpose of protecting the integrity of the free 
software distribution system, which is implemented by public license practices.  Many people have made 
generous contributions to the wide range of software distributed through that system in reliance on 
consistent application of that system; it is up to the author/donor to decide if he or she is willing to distribute 
software through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this 
License.

8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by 
copyrighted interfaces, the original copyright holder who places the Program under this License may add an 
explicit geographical distribution limitation excluding those countries, so that distribution is permitted only in 
or among countries not thus excluded.  In such case, this License incorporates the limitation as if written in 
the body of this License.

9. The Free Software Foundation may publish revised and/or new versions of the General Public License from 
time to time.  Such new versions will be similar in spirit to the present version, but may differ in detail to 
address new problems or concerns.

Each version is given a distinguishing version number.  If the Program specifies a version number of this 
License which applies to it and "any later version", you have the option of following the terms and conditions 
either of that version or of any later version published by the Free Software Foundation.  If the Program does 
not specify a version number of this License, you may choose any version ever published by the Free Software 
Foundation.

10. If you wish to incorporate parts of the Program into other free programs whose distribution conditions 
are different, write to the author to ask for permission.  For software which is copyrighted by the Free 
Software Foundation, write to the Free Software Foundation; we sometimes make exceptions for this.  Our 
decision will be guided by the two goals of preserving the free status of all derivatives of our free software 
and of promoting the sharing and reuse of software generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE PROGRAM, 
TO THE EXTENT PERMITTED BY APPLICABLE LAW.  EXCEPT WHEN OTHERWISE STATED IN WRITING THE 
COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF 
ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY 
AND PERFORMANCE OF THE PROGRAM IS WITH YOU.  SHOULD THE PROGRAM PROVE DEFECTIVE, YOU 
ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY 
COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE PROGRAM AS 
PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL 
OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM 
(INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES 
SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER 
PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Programs

If you develop a new program, and you want it to be of the greatest possible use to the public, the best way 
to achieve this is to make it free software which everyone can redistribute and change under these terms.

To do so, attach the following notices to the program.  It is safest to attach them to the start of each source 
file to most effectively convey the exclusion of warranty; and each file should have at least the "copyright" 
line and a pointer to where the full notice is found.



<one line to give the program's name and a brief idea of what it does.>

Copyright (C) 19yy  <name of author>

This program is free software; you can redistribute it and/or modify it under the terms of the GNU General 
Public License as published by the Free Software Foundation; either version 2 of the License, or (at your 
option) any later version.

This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even 
the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.  See the GNU General 
Public License for more details.

You should have received a copy of the GNU General Public License along with this program; if not, write to 
the Free Software Foundation, Inc., 59 Temple Place, Suite 330, Boston, MA  02111-1307  USA

Also add information on how to contact you by electronic and paper mail.

If the program is interactive, make it output a short notice like this when it starts in an interactive mode:

Gnomovision version 69, Copyright (C) 19yy name of author Gnomovision comes with ABSOLUTELY NO 
WARRANTY; for details type `show w'. This is free software, and you are welcome to redistribute it under 
certain conditions; type `show c' for details.

The hypothetical commands `show w' and `show c' should show the appropriate parts of the General Public 
License.  Of course, the commands you use may be called something other than `show w' and `show c'; they 
could even be mouse-clicks or menu items--whatever suits your program.

You should also get your employer (if you work as a programmer) or your school, if any, to sign a "copyright 
disclaimer" for the program, if necessary.  Here is a sample; alter the names:

Yoyodyne, Inc., hereby disclaims all copyright interest in the program `Gnomovision' (which makes passes at 
compilers) written by James Hacker.

<signature of Ty Coon>, 1 April 1989

Ty Coon, President of Vice

This General Public License does not permit incorporating your program into proprietary programs.  If your 
program is a subroutine library, you may consider it more useful to permit linking proprietary applications 
with the library.  If this is what you want to do, use the GNU Library General Public License instead of this 
License.



REGULATORY NOTICES

FCC STATEMENT This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to 
part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment. This equipment generates, uses 
and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, 
may cause harmful interference to radio communications. Operation of this equipment in a residential area is 
likely to cause harmful interference to radio communications, in which case the user will be required to 
correct the interference at their own expense.

INFORMATION TO THE USER If this equipment does cause interference to radio or television reception, which can be determined by 
turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of 
the following measures:

� Reorient the receiving antenna.

� Relocate the equipment with respect to the receiver.

� Move the equipment away from the receiver.

� Plug the equipment into a different outlet so that equipment and receiver are on different branch circuits.

If necessary, the user should consult the dealer or an experienced radio/television technician for additional 
suggestions. The user may find the following booklet prepared by the Federal Communications Commission 
helpful:

How to Identify and Resolve Radio-TV Interference Problems

This booklet is available from the U.S. Government Printing Office, Washington, DC 20402, Stock No. 
004-000-00345-4.

In order to meet FCC emissions limits, this equipment must be used only with cables which comply with IEEE 
802.3.

CSA STATEMENT This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment 
Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel brouilleur 
du Canada.

CE STATEMENT (EUROPE) This product complies with the European Low Voltage Directive 73/23/EEC and EMC Directive 89/336/EEC as 
amended by European Directive 93/68/EEC.

Warning: This is a class A product. In a domestic environment this product may cause radio interference in 
which case the user may be required to take adequate measures.

VCCI STATEMENT

BSMI STATEMENT
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